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Quick Start

RhinoCAM®
MILL Module 2026

Prefer Printed Documentation? Check Herel

What's New | Quick Start Play List

Quick Start Guides for each RhinoCAM module are available in both PDF and Video format. Refer
to the following information to access these resources:

[ RhinoCAM Supports Sub-D Models in Rhino

3 Axis Machining with Rhino 7 Sub-D
4 Axis Machining with Rhino 7 Sub-D
5 Axis Machining with Rhino 7 Sub-D

[D What's New!
What's New in RhinoCAM 2026

1] The Complete Quick Start Video Play List
Here is a link to the complete 2026 Video Play List

[D How to Access the Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
buttons located on the RhinoCAM Learning Resources dialog.

You will find:
e Quick Start Guides
e What's New documents

e Online Help links

© 2026 Mecsoft Corporation


https://mecsoftcorp.github.io/RhinoCAM-2026/Resources/RhinoCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QKPd8C9n44F7uOI4ZBUGnoU
https://mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2026.pdf

Quick Start 5

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module. To access the Learning Resources dialog:

1. From the Rhino Main Menu, drop down the Main menu and select Learn ...

&Y Untitled - Rhinoceros Mot For Ressle Lab - [Pesspective)

Fide Edit View Curve Surface Solid Mesh Dimension  Trensform  Tools Analyze Render Pamels  RhinoCAM Help

Command: | I_"'-‘- I,
Lt

Swandard  CPlanes  SetView  Display  Select  Viewportleyout  Visbility Transferm  Curve Tes FraehaiLL

DEESFXDO~ + 255 0 5Hw x5 0 H m

. FhinaCAM - Machinang Browser :U::&NET
P
Zj: MLl Program | Simalate o PGB0
: MESH
2 W Machine O Sock * o WorkZeo S dwim v M -
(?:IJG% o Pest B Align = = 2 Asis - i"’f SAxis * By - HEST
:}_'.-lj‘ B Setup = 2 Materal af 3l Adv & Heldes = e
{3‘ "1 Ma<h-?¢ Setup Dock Machining Clperatiors R
B P |5 Macinioglob
4 4 B Machine - 3Auis Check for Updates ...
ﬁ‘a 5 Post - Fanuclm License ...
= Stock - MHone Wabr-sitx
5@, 2
Foatwres - Mone
il el
B Setupt
& About .

To access the Learning Resources dilog in RhinoCAM

2. Select a document from the Learning Resources dialog to get started using the
module of your choice.

¥ You can also select the Open Quick Start Files Folder button located at the bottom
of the dialog to open the Quick Start folder where the source files (start and
completed versions) are located.
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| Learning Resources *

Welcome to RhinoCAM 2025!

To getstarted as guickly as possible use the following resources.

MILL TURN !
& @ U e W
What's Mew? Web Resources On-Line Help Quick Start On-Line Help Quick Start
Profile-MEST ———— G-Code
@ U e L ‘
On-Line Help Quick Start On-Line Help Quick Start
MEST ART
@ U e LU
On-Line Help Quick Start On-Line Help Quick Start

Where to go for more help:
To getyourspecific support questions answered click here to fill out a support form.

Forall otherinformation visit ourweb-site www.mecsoftcom

Open Quick Start Files Folder |

Learning Resources Dialog

© 2026 Mecsoft Corporation



Resource Guide 7

Resource Guide

Download this PDF Guide for a list of the available RhinoCAM Resources.

[T] 2025 RhinoCAM Resource Guide

\ff The 2026 RhinoCAM Resource Guide!

RhinoCAM 18 Pages

Resource Guide

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Check Here!

What's New | Quick Start Play List

© 2026 Mecsoft Corporation


https://mecsoftcorp.github.io/RhinoCAM-2026/Resources/RhinoCAM2026-Resource-Guide.pdf
https://mecsoftcorp.github.io/RhinoCAM-2026/Resources/RhinoCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QKPd8C9n44F7uOI4ZBUGnoU
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Avoid Fixtures in 2 Axis

If you have fixtures holding your stock onto your CNC table, you can avoid them automatically
during all 2% Axis toolpath operations. To implement this, follow the outlined steps below:

1. Inthe CAD system (Rhino or VisualCAD) create a 3D solid model of each fixture and position
them in the locations that they will appear in the actual setup on your CNC table.

WORLD 4185537 3431950 0oooo0  untsicH B e b £ /O OX A £t 1T B veraut facc]

2. If you currently do not have any 3D fixtures defined in RhinoCAM or Visual CADCAM, under
the Machining Job tree, right-click on the Fixture icon and select New Fixture from the
menu. You will be prompted to select the 3D objects representing each fixture. They must
be 3D solid (i.e., closed poly-surfaces). Do so and then press enter. This will display the

Create Machining Fixture dialog.
=4 - Machining Job
y Machine - 3 Axis
i Post- Acurite G2
ﬁ-ﬂ Stock - Box Stock

L] Fistures - Nong

= i‘i Setup 1 Mew Fixture L\}
| ) 2142 Ais brorimg
- ) 21/2 Axis Facing
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2

3. Your selected fixtures will be listed in the Fixture Geometry list.

Create Machining Fixture X

Fisture Definition

Fisture Mame: Fixture 2

Fisture Geometm

#  Selected Machining Feature(s)

1 Solid1

2 Salid2

3 Salid3 e 2

4 Solid4
L
wf’\\)

> Remove &l 2 Remove Active
[ Select Solidfs) Fisture Clearance Distance |02 5
Save Cancel Help

4. You can specify a Fixture Clearance Distance if desired.
5. Pick Save to close the dialog.

6. Your fixture will appearin the Machining Job tree.

© 2026 Mecsoft Corporation
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| Machining Job

I8 Machine - 3 Axis
:_;.'i' Post - Acurite G2
@ Stock - Box Stock

= @ Fixtures - Count 1

E ggup1
| 21/2 Axis Profiling
| ) 21/2 Axis Facing

7. Your fixtures are now defined but they are not yet applied to your setup.

8. Now, double left-click on the Setup icon in the Machining Job tree where you want the
fixtures to be applied.

=4 Machining Job
y Machine - 3 Axis
fs Post - Acurite G2

3y
fi'ﬂ Stock - Box Stock

Fistures - Count 1

| 21/2 Axis Profiling
| ) 21/2 Axis Facing

9. From the Setup dialog, pick the Select Fixtures for Setup tab.

| Setup , et

Define Setup Oriertation  Select Fistures for Setup
|

| Check the fistures to zelect for Setup

| B &8 Fistures Select Al

@ Fisture 1

De-zelect All

Canicel Save Help

10. Check the box next to the fixture you to apply to the active setup and pick Save.

© 2026 Mecsoft Corporation



Avoid Fixturesin 2 Axis 1

11. Now, for this setup only, toolpaths generated will automatically avoid the fixtures by the
distance specified in Step 4 above. If you have existing operations make sure you regenerate
them.

§ 1
-1~ Machining Job | i‘
y Machine - 3 Axis ’
iz Post- Acurite G2
@ Stock - Box Stock ’ v
| ) 21/2 Axis Facing i & 'ﬂ
= | Machining Job \.‘ }ﬁ»‘)“)j

y Machine - 3 Axis

i Post- Acurite G2 \, %

@ Stock - Box Stock < '@}}j UL
: 7

%

: ifﬁ({{{{{({ ,\
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Add a Tool Change Point

To output a Tool Change Point to your posted g-code files, please do the following:

1. From the Machine Setup dialog (Program tab > Machine > General Parameters > Tool

Change Pt), enter your required tool change point coordinates.

For the sample code (shown at the end of this section) we entered the following values in
the Machine Setup dialog:

X:-4,Y:0Z:0

Machine Tool Setup X

Machine Tool Definition

(®) Manual Definition (") Load From File
Machine Type
Mumber of Axes | 3 dxis ~
General Parameters

Tool Change Pt % |'4 | Sy |D

-

szl iy

Output all coordinates in local Setup Coordinate System

Tranglational Limits

Min x[5000 |5 v [s000 |5 z[Bom0 |2y
Max %[5000 |5 vw|s000 |5 zisooo |2
4th Az [Primarny fwiz) Parameters
0 . o oz o
1 +2

3. Edityour post processor by selecting Program tab > Post > Edit.

MILL iﬂ Program Simulate

I Machine f‘ﬂ Stock ™ o]

iz Post % Align =
g SetupNE Material

Select Post-Processor *

Select Post-Processor

Fost-Processor Type

.

(®) Use Legacy Post (") Use Programmable Post

Machine Setup Stock

Machining Job
= ac I:.:mghlo 3 i Select Post Processor

lf’ aching - = Current Post Processor:

%/ Post-Haas [T o Edit

Ej Stock - Box Stock - I:E

. N lder ta load post-pracessor files from:
netures - Mone C:%ProgramD ataskecSoft Corporation\ B hinoCakd 2027 for
= Setup 1 Rihita B.0%Pastz Millh 5Pk
21/2 Axis Facing

21/2 Axis Pocketin
21/2 Axis Pocketin
21/2 Axis Profiling

mmaa[ﬁ&

Cancel Help

MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

4. From the Post Process Generator dialog, select the Tool Change section from the left side

of the dialog.

© 2026 Mecsoft Corporation



Add a Tool Change Point 13

5. Inthe Tool Change Macro block section, replace the first line of text with the following
two lines of text at the top of the macro.
These two lines of text should precede the line that includes T[TOOL _NUM] as shown in
the examples below.

[SEQ_PRECHAR][SEQNUM][DELIMITER]GO Z[TOOL_CHG_PT_Z]
[SEQ_PRECHAR][SEQNUM][DELIMITER]GO X[TOOL_CHG_PT_X] Y[TOOL_CHG_PT_V]
[SEQ_PRECHAR][SEQNUM][DELIMITER]T[TOOL_NUM]

Post-Processer Generator x

Ganatal

Stat/End DUae 2 dhgit Format For Tool number and segisters

Tool Change:

:m Frst Load Taol Macio

Feed Rate |SEQ_PRECHAR)SEQMUM)DELIMITER]SPINDLE[DELIMITERIONDELIMITERSFEEDDELIMITERYSPINDLE_SPODELIMITERJFORWARD
Mation [SEQ_PRECHARISEQNUM)DELIMITER)IOUTPUT_MODE_CODEJDELMITERYG_CODEEMNEAT_HONMDL_Z)

Cicle |SEQ_PRECHARISEQNUMIDELIMITERIG_CODE PINEXT_NONMDL_XIDELIMI TERINEST_NONMDL_Y]

Hebeal'Spial

il Axis: Wotion

Cutter Compencation

Cut Motion Start/End
41 Cycles

Misc

Wariables

To-o-lE!tmgeMau:m

| ELI ITER)GO? L_CHG_PT %]

I PREI:MRISEurluMIDELIMItEﬂlTITUUL_N M]

JSEQ PﬁsmlssnuumloiumlEarsHNDLE[DELlMlTEﬁ)JN[DELlMszRISFEED[DELlMlTERlSHNDLE SPOIDELIMITERFORWARD
|SEQ_PRECHARSEQMUM|DELIMITER)OUTFUT_MODE_CODEJDELIMITER)G_CODE P[NE DL_Z)
|SEQ_PRECHARNSEQNUMYDELIMITER)G_CODE FMEXT_NOMMDL_<IDELIMITERNTMEXT | NEINMDI. _YIFEEDRATE_BLK]

Clase Saveds. Help

6. If your controller expects to see an optional stop call BEFORE each tool change, you can
add another line like below:

[SEQ_PRECHAR][SEQNUM][DELIMITER]GO Z[TOOL_CHG_PT_Z]
[SEQ_PRECHAR][SEQNUM][DELIMITER]GO X[TOOL_CHG_PT_X] Y[TOOL_CHG_PT_V]
[SEQ_PRECHAR][SEQNUM][DELIMITER]MO1
[SEQ_PRECHAR][SEQNUM][DELIMITER]T[TOOL_NUM]

7. Fromthe Post Process Generator dialog, pick Save As.
8. Enteraunique name for your post file (*.spm) for testing and pick Save.

9. From the Set Post-Processor Options dialog, select the revised post from the Current Post
Processor list.

© 2026 Mecsoft Corporation
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Select Post-Processor

Select Post-Processor

Post-Proceszsor Type
(®) Lse Legacy Post

Select Post Processar
Current Post Processor:

Crchd asters-tetic

Cricyr
Chchdasters-Inch
Ch etric-TCP
Crchasters-Metric
CMTMation
CR-OMSRUD_AMC
CR-OMSRUD_B&R
CR-OWSRUD_O5al
Creativel

cruzader

Datron
Tt abrewnd 1

(O Use Programmable Pozt

Edit ...

fior

Help

10. Note: If you do not see your revised post in the list, select the "..." button to the right of
the "Folder where post-processor file are located" and select the folder where you saved

your revised post file to (see Step 7 above) and pick OK.

11. You should now see your revised post in the list. Selectit and pick OK.

12. Post a sample toolpath using the revised post.

13. Review the g-code test file and locate the first tool change lines of code.

14. Your sample test should look something like this depending on your post (based on the
tool change point we used in Step 2 above). Note the tool change coordinates in blue:

N66 ;2 1/2 Axis Profiling

N68 GO Z0.
N70 GO X-4. YO.
N72 T1 MO6

15. That's it!
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Add more Materials

This topicis intended for advanced users who are familiar with XML text editing and have
administrative access to their Windows Operating System. RhinoCAM has a built-in Feeds &

Speeds Calculator that can suggest Spindle Speeds and Cut Feed Rates based on your stock
material and active tool parameters!

However, what if you are cutting stock material that is currently not in our Materials Library? Or

what if you don’t like what is currently assigned for the material of your choice in the Materials
Library?

This topic will show you how to customize RhinoCAM to add and manage multiple material files as

well to add your own stock materials. If you are new to RhinoCAM, you can review the topic The
Feeds & Speeds Calculator.

[T] How Materials are used

First let’s review how material definitions are used in RhinoCAM. From the Stock pane
of the Program tab in the Machining Browser you will find the Material icon. Selecting it
will display the Select Stock Material dialog. Here you can select a stock material from
the Material File. If there is an associated Material Texture file, then this texture is
assigned to the stock model and rendered in the graphics window. This texture
rendering on the stock can be toggled on or off using the Material Texture Visibility icon,
located at the base of the Machining Browser.

Select Stock Matesial =
Choone Shodk: Mabenisl
MILL|' 3| Program | Simulate o H B0 Material Fie
3 Macnine (D) Stock © o WorkZero B 4axis * B - FeedsSpeedsDatalNCH.aml
e hign = | =F 2ads v {0 SAwis - TR -
o Post ﬁig =0 2a j) 5 Material
Setup = 3§ Meteial | AT 3 s adv - [l Holes -
hine Setup Stock Machining Operations WooD bl
Machin] Material [
o M Material Texture
= §= Define Stock Material
i Po
MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST
|
6 2o o o T 3 Defat - |
L
VisualcaM - Mat_erialTExtureVisibi\ity o
T oo & iyt PR e
T ey TTETT Source folder for matenial flss:
=]y Toals ~
T 375 4FL (2550 Loc) _wmw%ﬁMwaamﬁ
- S Lo
The Material icons in the Machining Browser /
Cancel
MILL Module shown, Similar for MILL-TURN, E s
TURN and Profile-NEST The Select Stock Material dialog

© 2026 Mecsoft Corporation
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[T]

Also, from the Feeds & Speeds tab on the Create/Select Tool dialog you can select Load
from File to display the Feeds & Speeds Calculator dialog. The Material selection in this
dialog will default to the stock Material you have previously selected from the Select
Stock Material dialog (shown above).

Location of Material Files

The Material selections available to you from these dialogs are retrieved from a Feeds &
Speeds XML file installed with the program. There are separate files for INCH and
METRIC units. The files are located in the \Materials folder of the ProgramData install
path of the program.

Here is an example: C:\ProgramData\MecSoft Corporation\Program Name &
Version\Materials.

ﬁ By default, the Windows Operation System does not display the

ProgramData folder to you. If you do not see it, login as
Administrator and from the Windows Control Panel, navigate to the
File Explorer Options dialog, select the View tab and then select the
option to Show hidden files, folders, and drives and pick OK.

Maintaining Multiple Material Files

You can create your own Material Files and store them in the default folder. The CAM
system on startup will load all material files in the folder specified in the dialog above as
long as the units of the material files match the part units that you are working with. If
the system finds multiple material files with matching units, it will populate the drop-
down control in the Materials dialog allowing you to select a specific material file to suit
your needs.

ﬁ You need to make sure that you have the units specified correctly

in your customized materials XML files or your material files will
not appearin the dialog list. See item #5in the Editing the Feeds &
Speeds XML File section below for the correct Units format.

Having multiple material files can help manage different materials and associated feeds
& speeds data without having to cram all of the data into one file. In addition, multiple
material files may be useful if you have multiple machines in the shop with different
power capabilities and you want to use different feeds and speeds settings per machine.
Under this scenario you could have one material file per machine saved in the default
folder and load the correct material file depending on which machine you are
programming toolpaths for.

Editing the Feeds & Speeds XML File

© 2026 Mecsoft Corporation
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Material files can be edited to customize the data stored in these files to suit your shop

needs.

ﬁ CAUTION!! - Before editing material files - Make sure you create a

copy and keep them in a safe place, outside of the install path of

the program. Also, make sure you maintain the XML format of these
files or the Feeds & Speeds Calculator may not work properly! The
file names are:

FeedsSpeedsDataINCH.xml
FeedsSpeedsDatalNCH.xml

Here are the steps required to add new material definitions. Be sure to read these steps

carefully:

1. Make a backup copy of the Feeds & Speeds XML files!

2. Edit the XML file to add the material definitions needed, paying close attention
to the format of the XML file. This file can be edited with any ASCII text editor
such as Notepad or any XML editor.

3. Each Material defined in the XML file has several records (or lines of text)

associated with it. Each line of text defines information about that Material for
each instance itis referred to by the Feeds & Speeds Calculator. Here is a sample
section for Aluminum 2026.

<Version>1.0</Version>

<Units>Imperial</Units>

<FeedsSpeeds>

<Material>
<Name>ALUMINUM - 2026</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>

</Material>

© 2026 Mecsoft Corporation
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Here is what the file looks like in tabulated form:

o Tt | ity | S5 [
ALUMINUM - 2024 MILLING | CARBIDE | 1800.00 0.0040
MILLING HSS 40000 0.0040
MILLING [ CERAMIC | 400.00 0.0040
DRILLING | CARBIDE | 950.00 0.0048
DRILLING HSS 240.00 0.0048
DRILLING | CERAMIC 240.00 0.0048
TURNING | CARBIDE | 1800.00 0.0200
TURNING | CERAMIC | 1800.00 0.0200
TURNING | CERMET | 1800.00 0.0200

ALUMINUM - 5050 MILLING | CARBIDE | 1600.00 0.0040
MILLING HS55 400.00 0.0040
= A Y

You will need to know the Surface Speed and Feed/Tooth specifications for each
instance of the Material you are adding to the XML file. Here is the information
format:

<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>

You need to make sure that you have the Units format specified correctly in your
custom material XML files. Itis defined on the 2nd line of the Materials XML file.
For Inch units use <Units>Imperial</Units>and for Metric units use
<Units>Metric</Units>as shown here for Inch:

<Version>1.0</Version>
<Units>Imperial</Units>
<FeedsSpeeds>
<Material>

There is also a bitmap image file (*.bmp) associated with each Material type
defined in the XML file. This image defines the texture thatis applied to the
Stock material when the Toggle Material Texture Visibility icon is enabled. The
image is also displayed in the Select Stock Material dialog.

© 2026 Mecsoft Corporation
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Select Stock Material x

Choose Stock Material

Material File

|FeedsspeedsDataNCH.xml |

Material

| ALUMINUM - 2024 v

Material Texture

Source folder for material files:

gramData'MecSoft Corporati |

I CK || Cancel || Help |

Dialog Box: Select Stock Material

Here is the list of the material texture map files currently installed. Make sure
your bitmap image file name matches the name entered into the Materials XML
file or the No Texture Map icon will display instead.

Aluminum.brmp Brass.bmp Castiren.bmp Copper.bmp FeedsSpeedsData  FeedsSpeedsData

INCH.oml MMaml|

[T — —
Graphite.bmp Hastelloy. brp Inconel.bmp Iron.brnp Magnesium.bmp  Molybdenum.bm
P
el ‘ .
i
Manel.bmp Mickel brap NoTetureMapb Plastic.bmp Steel.bmip Titanium.bmp

mp

L
Waspaloy.bmp wood.bmp

D:I Let’s Review

Adding specific materials you use regularly in your shop to the Feeds & Speeds Calculator
in RhinoCAM can save toolpath programming time and help ensure cut surface quality

© 2026 Mecsoft Corporation
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and machining time accuracy. Just be sure to review this post carefully. A summary is
also listed below. If you need help, you can always contact us at MecSoft Support via the
phone, web or email.

1
2.

You can select a Material to be applied to your Stock definition.

The selection of materials are retrieved from an external data file (example:
FeedsSpeedsDatalNCH.xml) located in the install path of RhinoCAM on your
computer.

The XML data file can be edited with any ASCII text or XML file editor.

The XML data file also contains information about the CAM Module, Tool
Material, Surface Speed and Feed/Tooth for each instance of the material.

The stock material selected is used by the Feeds & Speeds Calculator to suggest
Surface Speeds and Cut Feed Rates.

The Feeds & Speeds Calculator is displayed when you select Load from File from
the Feeds & Speeds tabs of the Create/Select Tool dialog or from each toolpath
operation dialog.

You can manually add more materials to the XML data file. You will need to know
the recommended Surface Speed and Feed/Tooth specifications for the material
you are adding based on each Tool Material type.

Itis very IMPORTANT that you make a backup copy of these XML files if you plan
to edit them. Also, the text format of the XML files is VERY IMPORTANT. If the
formatisincorrect, the Feeds & Speeds Calculator may not work properly! Make
sure that the Units format on line 2 matches the Units you plan to use in your part
files.

Each material also has a bitmap image texture file (*.bmp) thatis located in the
same folder. The material texture image is shown in the Select Stock Material
dialog and is also applied as a texture map to your stock when the Toggle
Material Texture Visibility icon is enabled.

© 2026 Mecsoft Corporation



Add Tool Comments 21

Add Tool Comments

You can add comments associated with a Tool. These Comments are saved with the Tool in your
Tool Library. They are also posted to your g-code when the tool is used.

Here are the steps to add Comments to a Tool:
1. Editthe Tool using the Create/Select Tool dialog.
2. Select the Properties tab on the right.

Create/Select Tool n
gaEaVHHEBLLYO=ZBVNNIRY
Toolsin Session H“"’E'Ta“'_.lL Jllllld Properties  Feeds & Speeds
Holder Material | CARBIDE ~
Haold: 1
Ao Length Cut Matesial Color | ~
T I ) m : 1 Mumbes of Futes |2 -
Diameter Tool Numbes _1 :
Toal P sdwtRegae 1 -
Length I I |
Shoulder Rl g —F— [ T Cubcom Regaster |1 =
Length Axial Dlfest 0 :
Flute _ assaRaiE .
Length 1 1 Coolant | Mone: hd
| | Comments

Tool Diameter *
Name [Pl ' RERRRRRES |

SharkDia  Toollen  ShouderLen
12 (2l (a0 [ [e

Fhtelen  ToolDia

&0 = (12 =
Holdar | Dratailt Holder ol 12
Sanve sz Mew Tool Save Edis to Tool Dielate Tool
: > Cencel Heb

3. Add text tothe Comments window.

Properties  Feeds & Speeds

Material | CARBIDE w
Cut Material Color | ] =
Mumber of Flutes |4 =

T ool Mumber Il =
Adjust Register 0 =
Cutcom Fegister |0 =
fial Offset E =
Coolant | Mone w
Camments

My T ool Comments herel]
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4. Make sure Comments are enabled in your post.

A. Click on Post (Set Post-Processor Options), then click Edit.

MlLLle Pragram Simulate| Select Post-Processor *

Machi Stock ™
M Machine J Stoc v Select Post-Processar

i Post % Align = | =]
by SHUN Material ,@ Fost-Processor Type

. (® Use Legacy Post () Use Programmable Post

Machine Setup Stock / Current Version: 2021.2

Machining Job
= ul achining . ° . Select Post Processar

3{’ Machine - 3 fixis Current Post Processor:

@ Post-Haas Haas o || Ed..

fEi Stock - Box Stock . I:Bs

. N lder ta load post-pracessor files from:
@ netures - Mone C:4ProgramD atasMecSoft Corporation R hinoCakd 2027 for
= E Setup 1 Rihita B.0%Pastz Millh 5Pk

[ 2 1/2 Axis Facing

| 271/2 Axis Pocketin

| ] 21/2 Axis Pocketin

|} 21/2 Axis Profiling

Cancel Help

MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

B. From the Post Processor Generator dialog, select the General tab from the left.

C. Checkthe box to Output Comments. You can also change the start and end
characters to use.

Post-Processor Generstor £\ ProgramBataMecScft Corporation'VisuslCAM 2017\ Pasts\ MILL\WinCHE spm 4
Stat/Erd Fibe: Contscl Mode Comments
ool Change
Senp _
Spanch Fie Stat Rieading Char (@) Abwhge  Code| G0 A Ouons Comerant
Feed Fate ! .
Mo : : Carinent Stad Char |[
Cacle . . - . *.
Hebcal/Spaal Fie Stop Readeg Char [ | Orcoomental = Comment End Chas ||
Mg Fudg Moton
Cutes Compensation [ Outpt spassrice rumiets
Cut Mection Sl Erd
[
3 Cpcler Sequence s Urits
Misz
B Biock Format
Vet [Use Sequercs 82
@ Irch Code G20
Delenicer
: O Mt 5o Olone  ®Space O Tabs
() Uses Diesfinesd)
Modal Qutpu End of Blsck Chaacter
[ GCads B Feaceas [ dibszaes e = sign
43 [ Comdinste A Spindie speed A Showe Leading Zeros

Cose || Sewmis el
D. Then pick Save or Save As.

5. Now post your operations and see your comments:

G1 X0.5301 Y-0.7171 Z0.7480
G3 X0.7801 Y-0.4671 10.0000 J0.2500 F2.6
G1 X0.7801 Y-0.2171 Z0.7480 F6.9
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GO0 Z0.9843

GO0 X0.7801 Y-0.2171

(2 1/2 Axis Profiling)

(My Tool Comments Here!)
S18000

G0 Z0.9843

GO0 X0.5301 Y-0.7097

G1 X0.5301 Y-0.7097 Z0.7480 F6.9
G1 X0.5873 Y-0.7097 Z0.7480 F3.4
G1 X0.5873 Y-0.6345 Z0.7480

G1 X0.4729 Y-0.6345 Z70.7480

6. If you want to post g-codes instead of comments, just place a S character prior to the
comment in the Create/Select Tools dialog. Adding S as prefix will skip the comment start
& end characters in the posted code.

Properties  Feeds & Speeds

Material | CARBIDE ~

I

Cut Matenial Color

=

MHumber of Flutes

=

Tool Mumnber

=

Adjust Register

=

Cutcom Register

P S 1 S S S Y

Axial Offzet

i

Coolant | Mone ~

Comments

$My g-code Herel

G1 X0.4655 Y-0.7171 Z0.7480

G1 X0.5301 Y-0.7171 Z0.7480

G3 X0.7801 Y-0.4671 10.0000 J0.2500 F2.6
G1 X0.7801 Y-0.2171 Z0.7480 F6.9
G0 Z0.9843

GO0 X0.7801 Y-0.2171

(2 1/2 Axis Profiling)

My g-code Here!

S18000

G0 Z0.9843

GO0 X0.5301 Y-0.7097
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G1 X0.5301 Y-0.7097 Z0.7480 F6.9
G1 X0.5873 Y-0.7097 Z0.7480 F3.4
G1 X0.5873 Y-0.6345 Z0.7480
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Align the Stock & Part

If your Stock is not aligned correction with the Part model you can change it.
1. Selectthe Program tab.

MILLI"_[B Program Simulate & & @

y Machine aStock v ‘- Work Zero 6‘-;4Axi5 - B

1% Post 88 atign - | = 2 s ~ & 5 mis - -

i:t Setup ~ !E Material U 3 Axis Adv T l—IE—IHDIes *
Machine Setup Stock Machining Operations

= Machining Job

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

2. @ N Select the Align menu.

Align
3. Stock | select Align Stock from the menu to display the dialog.

Align Part and/or Stock Geometry X

Align Stock about Part

£ Alighment

O Top () Center (®) Eattom

=y Alignmment

(O Maothwest () Marth () Marth E ast
(O Midwest (®) Center () MidEast
(O Southwest () South () South East

Ignore Wireframe Geometry in Part Bounds Computation

Cancel Help

4. Firstselect the Z Alignment by select Top, Center or Bottom. For our example we will

select Bottom.

5. Then select an XY Alignment option. Nine different locations are available. For our
example we will select Center.
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6. The Stock displayed on the screen will move then you make selections from this dialog.

“,h " e | Stock in Z Added |

Extra Stock is on top \*

1.« )

A Stock Z Alignment = Bottom

7. Againif you have curves or other non-part wireframe geometry displayed, you can check
the box in the dialog to ignore them when calculating the alignment.

8. Pick OKto close the dialog.

Alternatively you can move the actual part model in relation to the Stock if desired. IMPORTANT:
This option will physically move the location of your part geometry. This command is useful when
you have opened or imported part geometry that is NOT in the correct location for machining.

1. Open the part that you wish to align.

2. Define the Stock dimensions and location. See How to Define a Box Stock for more
information. Our example part looks like this:

3. Selectthe Program tab.
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MILL iﬂ Program Simulate & -8 @

y Machine e Stock ~ ‘. Work Zero g‘-'.tl#\xis hd _‘}%'
25 Post %Angn - | = 2 s - {;75@5 - Bg.
Setup ~ !E Material I\J: 3 Axis Adv ~ I—i,—IHoles hd

Machine Setup Stock Machining Operations

= Machining Job

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

4. @ " Select the Align menu.

Set
5. WorldCS gelect Set World C.S. from the menu to display the dialog.

Locate World Coordinate Systemn X

Locate WS with rezpect to Part or Stock,

SetWCS Origin
(O Pick (@ SettoStock Box () Set to Part Box

Zero Face
(O Highest 2 O MidZ ® Lowest 2

Zero Position
(O Morthwlest (O Marth () Morth East
O West () Center () East

® South'west () South () South East

><: SFECTI N ST TR

Catcel Help

Remember that this dialog will physically MOVE your part geometry!

6. Firstselectan option from the Set WCS Origin section. This sets the new WCS Origin. In
this example we select Set to Stock Box. We want to move the partin relation to the
currently defined Box Stock.

7. Then define the ZERO Face. This aligns the partin Z. In this example we select Lowest Z so
the WCS Origin of the part will move in Z to the bottom of the Stock Box.
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8. Then define the Zero Position. There are nine cardinal directions to choose from. Each is
in relation to the current Box Stock. In this example we select South West so the WCS
Origin of the part will move to this position on the Stock.

This is our desired part location:

[T] Related Online Help Topics
User Interface

Align Stock
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Assign a Stock Material

You can optionally assign a Material definition to your Stock. The Material definition is used for

display purposes. It will also be automatically fed into the Feeds & Speeds Calculator when itis
displayed.

1. Currently we have a part loaded and stock defined and toggled on.

2. Selectthe Program tab.

Program Simulate & g~ @

v Machine aStock v ‘- Work Zero gcc-hﬁxis v ﬁ'
15 Post Biaign - | Fomis - s - e

(isetup v 3= Material | A 3 Auis Adv ~ il Holes -
Machine Setup Stock

&l Machining Job

Machining Operations

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3. | 35 Material| .o Material to display the dialog.
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Select Stock Material *
Choose Stock Material

Material File

FeedsspeedsDatalNCH.xml |

Material

| ALUMINUM - 2024 v|

Material Texture

Source folder for material files:

gramDataMecSoft Corporati |

| QK || Cancel || Help |

Dialog Box: Select Stock Material
4. Selecta Material from the selection menuin the dialog. A preview of the Material texture
will display in the dialog.

5. Materials are stored in a Material file. The default Material File is pre-selected from the
menu.

6. The folder location where the Material File is located is indicated in the field at the
bottom of the dialog. This location cannot be changed.

7. Inthe future you can add material definitions to the Material File or create your own
material file.

8. Pick OK to close the dialog.

9. |‘°¥:| To see your selected material display on the stock, select the Toggle Material Texture
Visibility icon located at the bottom of the Machining Browser - second icon from the left.
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& (B

Material Texture Visibility

635 Toggle Material Texture
Visibility on Stock

MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

1] Related Online Help Topics

User Interface

Material

31
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Control the Cut Side & Start Point

Our support staff speaks with users on a daily basis and new
users have many questions. One of the questions asked
oftenis:

Start Point
. . & Direction
How can | control the cut side and the cut start point of my 2

Axis toolpaths?

This article addresses this question is detail. To get many I<
more of your questions answered be sure to get the 5
Question & Answer Guide available for each of MecSoft's
CAM desktop Plugins. As an Annual Maintenance
Subscription (AMS) subscriber, this guide and other training
materials are available to you as part of your annual
subscription. To learn more about AMS or to become an
AMS subscriber just give us a call at (949) 654-8163 option 1 for Sales or contact
sales@mecsoft.com today.

Each curve has a Start point, Direction and an End point. The Right Hand side of the curve is
determined by the curve direction. These definitions are shown in the illustrations below. In 2
Axis machining methods the Cut Start Point is defined by the Start Point of the selected curve
regions

So controlling the curve Start Point is critical in controlling the Cut Start Point of the 2 Axis
toolpath.

[T] Understanding Curve Geometry

To answer this question, we must first talk about curve geometry (i.e., line, arcor
spline). Collectively we will call them curves. Each curve has a Start point, a Direction
and an End point. If you position yourself at the start point and face the direction the
curve is traveling, then your right and left hand will govern the right and left side of the
curve.

These definitions are shown in the illustration below. In 2-1/2 Axis machining methods
the Cut Start Point is defined by the Start Point of the curve region. Thus, controlling the
curve Start Point is critical in controlling the Cut Start Point of the toolpath. For closed
curves, Inside and Outside can be used to control the side to cut. If the curve is a surface
edge of a 3D solid model, you can also allow the program to determine the correct side
to cut based on the part’s topology.
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Curve —»
Curve
Start Point Direction
Left Side @ @ Right Side

The Start Point, Direction and Cut Side of Curves Geometry

[T] When Machining Multiple Curves

When more than one disconnected curve is selected for one machining operation each is
obviously treated as a separate curve region, each with a unique cut start point.

When multiple curves that are located end-to-end are selected for
one machining operation it is highly recommended that you first
merge or join the curves into one poly-curve. Doing this first will
define a single cut start point for the entire poly-curve.

W

y NOTE: If the curves are left disconnected, the start point of the first
curve selected for the machining region will serve as the cut start

point. You can move a curve to the top of the Selected Machining

Region(s) list and its start point will become the cut start point for the

operation.
-~ Start Point Unique
first curve Start Point
selected /
Individual Curves Joined Poly-Curve

[T] Error - open loops found!

If you get an "open loops found!" error message when generating an operation, this
means that the machining regions you have selected are not joined when the operation
is expecting them to be. 2-1/2 Axis Pocketing is one operation that expects closed
curves. Thisis why it is always good practice to join closed curves into one poly-curve
before being used in a machining operation. The following illustrates open loop
conditions:
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Disconnected Curves

Qverlapping

Curves

Self-intersecting Curves

1] How to Identify Start Points in CAD

You can identify and display curve start point and direction arrow indicators using your
CAD system tools and commands.

1. Atthe command prompt type the command crvseam and press <Enter>.
2. Select the curve to identity and press <Enter> again.

3. Start point and arrow indicators will appear..

[T] How to Change a Curve's Start Point in CAD

You can use your CAD tools to move the Start Point of a curve. See the section above on
How to Identify Start Points before continuing.

1. Atthe command prompt type the command crvseam and press <Enter>.

2. Selectthe curve to modify and press <Enter>again. Then select a point on the
curve that you want to move the start point to..

[T] How to Change the Start Pointin CAM

In RhinoCAM you can use Pre-Defined Regions to control the Cut Start Point, Direction
and other aspects of your machining regions. This is a convenient method because it

works on both curves and surface edges.
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1 D‘mJ To the left of the Program tab, select the Tools Machining Objects icon to
make sure the Machining Objects Browser is displayed.

MAILL Program Simulate

2. Select the Regions tab.

W Teols Gﬂﬂjiﬂﬂs %Features %ﬁ K-Bases
Al L liemlelelslelele

| Machining Regions

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3. |@| Pick the Select Curves icon.

W Teols Gﬂegiﬂns %Features %ﬁ K-Bases
@B ERERER A

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

4. Selectthe curves or surface edges that you want to create a pre-defined region
from and then right-click or press <Enter>. The example below we select the top
outer surface edge.

5. A Machining Region Set is created and added to the Machining Regions list with
each curve/edge listed. In this example only one region is created. Itis selected
by default and the regions is displayed on the part with the start point and
direction indicated.
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WD Tools GRegions ‘Features %E K-Bases
R ELEABERB &
=[] Machining Regions

E% Machining Regions Set 1

WMW

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

Select Start Point icon to enable start point editing.

6. @ With the curve region selected from the Machining Regions list, pick the

7. Now select a new start point anywhere along the pre-defined region. The start

point will move to that location.
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8. @ Notice that the Select Start Point icon is still enabled. You can select

another location for the start point if desired.

Take a moment to familiarize yourself with the other cool Region commands on
the toolbar and use them to save time and control your toolpaths.

Create Machining Region Set

Select Curve

Select Surface Edge Areas

BB O

Flat Areas Selection Filter

£

{| Select Flat Areas

Select Start Point

Reverse Cut Direction

Automatic Bridge Points on Selections
Manual Bridge Points on Selections
Delete All Bridge Points in Selections

Edit Bridge Point in Selections

BREOMNA G

Clone Region

[T How to Select Pre-Defined Regions for a Toolpath

Once you have created a Pre-Defined Region with its Start Point defined you can use
them as machining regions in any toolpath operation.

1.

Create a toolpath operation as you normally would. See How to Generate a
Toolpath for more information.

Select the Control Geometry tab.

& Select Pre-Defined Fiegions Pick the Select Pre-Defined Regions button to

display the dialog.

Select the region(s) for the toolpath operation and then pick OK to close the
dialog. You can select one or more regions or a region set.
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Select predefined Machining Regionis) n

E-| | Machining Regions
= (83 Machining Regions Set 1

(@] Curve Region 1

5. The Pre-Defined Region is added to the list of Selected Machining Region(s). Itis
listed as a Curve Region and can mixed with other curve or drive regions in the
list.

21/2 Axis Profiling X

CutLewels  Entry/Exit  Advanced Cut Parameters Comenng Parameters Sorting
Control Geometry Tool Feeds & Speeds Clearance Plane Cut Parameters

Part Regions  Awoid Regions  Start Points

Selected Machining Region(s)
DriveRegion 1
DriveRegion 2
DriveRegion 3

(TR - -

6. Now Generate the toolpath as you normally would and the Start Point of the Pre-
Defined Region controls the Cut Start Point of the 2 Axis toolpath. In this
example, itis a Profiling toolpath.

7. NOTE: If you are generating a 2 Axis Profiling toolpath and your entry IS NOT
being located at the curve start point, go to the Cut Parameters tab and make
sure the option called Use Mid-Point of Longest Side is not checked. Ifitis,
uncheck it and Generate the operation again.

Cut Start Point for Clozed Curves
[ ]Use Mid-Paint of longest side
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(1] Cut Start Point Controls in other Methods
Here is a list of the toolpaths that allow for Cut Start Point control.
1. All 2 Axis toolpath methods.

2. 2 Axis Roughingand 2 Axis Pocketing have an additional Start Points sub-tab on
the Control Geometry tab where you can define Cut Start Points.

3. 3 Axis Horizontal Roughing and 3 Axis Horizontal Re-Roughing also have an
additional Start Points sub-tab on the Control Geometry tab where you can
define Cut Start Points.

4. Other 3 Axis methods have various parameters that control the toolpath so be
sure to review all of the controls on the Cut Parameter tabs for each operation
type.
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Copy/Edit a Toolpath

Toolpaths can be combined to machine complex objects. In our How to Generate a Toolpath
example, we showed you how to generate a single 2 Axis Pocketing toolpath. However, you
might of noticed that example only cut the bottom portion pocket. There is also a pocket above it
that has different geometry.

Note that all roughing and finishing toolpaths can be generated in any order. Re-Roughing
requires a previous Roughing toolpath to be generated and simulated first. However when
completed, itis a good practice to have each toolpath appear in the Machining Job in the order
you plan to machine them. You can change the order of the toolpaths after you generate them.

In the example below we create the 2 Axis Pocketing toolpath for the top level of the pocket from
a copy of the previous toolpath. We will them move it up in the Machining Job.

1. Firstread How to Generate a Toolpath topic and then proceed.

2. Selectthe Program tab.

MILL|'T3| Program Simulate & F-8@

y Machine @ Stock ™ ‘. Work Zero 6‘!.4!—&& - B
15 Post Biaign - | Fomis - s - e
Setup 3= Material l\_f, 3 Axis Adv l—i.—lHoles ™
Machine Setup Stock Machining Operations

= Machining Job

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3. Select atoolpath from the Machining Job, right-click and select Copy from the menu.
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=-{,- Machining Job

I8 Machine - 3 Axis

355' Post - Haas

S Stock - Box Stock

@ Fixtures - None

=] ﬁﬂetu[ﬂ

‘.WorkZero

"

[ 21/2 AxisE @ Regenerate

Al
)

% Post

Simulate

& ¢

Simulate Until

\
L
oy

Informaticn

# =

Edit
Rename
Suppress
Cut

Copy %

Paste

Gl

Clone

s

Save to Knowledge Base

Save As Defaults

lj’ Properties

Machining Browser: Copy an Operation - Premium
Configuration Shown

4. Now right-click on the toolpath again and select Paste.
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=-{, - Machining Job
y Machine - 3 Axis
i Post- Haas
ﬁ Stock - Box Stock

@ Fixtures - Mane
= ﬁ Setup 1
‘. Work Zero
[ -

[ 2142 Axi @ Regenerate
‘l:; Post
@ Simulate
Simulate Until
Information

Edit

# =

Rename
Suppress
Cut
Copy

Paste

0 i 3¢ G

s

Clone

i

Save to Knowledge Base

Save As Defaults

j’ Properties

5. A copy of the toolpath will appear in the Machining Job below the original.

=4~ Machining Job
I8 Machine - 3 Axis
{2 Post- Haas
a Stock - None
@ Fixtures - None
=] ﬁ Setup 1
‘. Work Zero
() 2 1/2 Auis Pocketing (Lower)
| 1 21/2 Axis Pocketing (Lower)

MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

6. Now selectthe second operation, right-click and select Rename.
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= Machining Job
y Machine - 3 Axis
s Post-Haas

@ Stock - Mone
_@ Fixtures - Mone

= [ Setup 1
‘. Work Zero
2 1/2 Axis Pocketing (Lower)

2 1/2 Axis Pocketing (Lower
@ Regenerate

l“" <
i Post

Simulate

Simulate Until

/'!'\ .
\2.) Information

E Edit

Rename

s

i Suppress

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

7. The name of the operation will be activated for editing. Change the name as desired and
then select anywhere outside of the name to accept the edit. In this example, we
changed the name to 2 1/2 Axis Pocketing (Upper).

E Machining Job
y Machine - 3 Axis
s Post-Haas
@ Stock - Box Stock

_@ Fixtures - Mone

=% Setup 1

‘. Waork Zero

2 1/2 Axis Pocketing (Lower)
[21/2 Asis Packeting (Upperd |

s

MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST

8. Now left-click on the folder to the left of the copied operation and Drag it up until you see
a horizontal bar appear. This line indicates to you where in the Machining Job tree the
operation will go if you release the left-mouse button.

When you see the horizontal bar appear above the operation where you want to move to,
release the mouse and the operation will move to that location.
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=4 Machining Job
-3 Machine - 3 Axis

-#54 Post - Haas

Drag upward until you
iﬁ Stack - None see the bar appear Here.
@ Fictures - None | Then release the mouse.

BE Setup 1 /

‘- Work Zero
|_ 21/2 Axis Pu:l‘gketing (Lower)
Eh- |2 1/2 Asds Pocketing (Upper;

/

Left-click on the
folder Here.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

=-{,- Machining Job
y Machine - 3 Axis
{2 Post- Haas
a Stock - None
@ Fixtures - None
=] ﬁ Setup 1
‘. Waork Zero
() 2 1/2 Auis Pocketing (Upper)
| 1 21/2 Axis Pocketing (Lower)
MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

9. Now right-click on the operation you just moved and select Edit to display the toolpaths

operation dialog.

=4~ Machining Job
y Machine - 3 Axis
{% Post- Haas
S Stock - Mone
@ Fixtures - Mone
=K Setup1

‘.' Work Zero

() 2 1/2 Axis Pocketing (
[ ) 2V2hisPe o Regenerate

‘!‘;;. Post
@ Simulate
Simulate Until
K:!) Information
E Edit
Rename %

[ é Suppress

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST
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2 1/2 fxis Pocketing X

Cut Parameters  Cut Lewvels  Pocketing Entry/Exit Advanced Cut Parameters  Sorting
Cantral Geometry Tool Feeds & Speeds Clearance Plane

Fart Regions  Awoid Fegions  Start Paints

#  Selected Machining Region(z)
1 DwiveFlat Area 1

\

Avoid
Region

£ >

Move Up | il Move Down

> Remave sl | 2 Remove Active

[Q Select Curve/Edge Fegions

Select Surface Boundary

Ry Select Flat Area Regions
[-Q Select Pre-Defined Regions

Cancel Save Help

o5 emmeil The remaining procedure is similar to How to Generate a Toolpath so we
will not show each dialog. From the Control Geometry tab select the Remove All button
to remove the machining regions from this list.

10.

11. R Select Curve/Edge Regions Now pick the Select Curve/Edge Regions button and the
dialog will minimize.

12. Select the face edges around the top perimeter of the upper pocket. Then right-click or
press <Enter>to continue.
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13. Pick the Cut Levels tab and change the Location of Cut Geometry to At Top.

Location of Cut Geometry
@ AtTop () AtBottom

(O PickTop 0 R

14. The remaining tabs and parameters can remain the so we pick Generate to
calculate the toolpath and display it on the screen.

15. Lﬁj If you do not see the toolpath displayed, select the Toggle Toolpath Visibility icon
located at the bottom of the Machining Browser.

|
B 3P & (B

Toolpath Visibility

5 Toggle Toolpath Visibility
”Lm Tools K-Bases

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST
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Create a Setup Sheet

You can generate a Setup Sheet for one or more toolpath operations. There are several templates

available to choose from. Each provides various degrees of information for the selected
operations.

To generate a Setup Sheet:

1. Create and adjust the toolpath operations that you want to estimate.

2. Make sure the toolpaths have generated cleanly. Each toolpath when generated is listed

under a Setup in the Machining Job. If the operation is flagged it means that it needs to be
regenerated.

= Machining Job
‘y Machine - 3 Axis
i Post- Haas
a Stock - Mone
@ Fixtures - Mone

- [ Setup 1
- ‘. Work Zero
21/2 Axis Pocketing (Upper)
2 1/2 Axis Pocketing (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Select the Setup that you want to create a Setup Sheet for. You can also select the
Machining Job.

= Machining Job

y Machine - 3 Axis
2 Post- Haas

a Stock - Box Stock
@ Fixtures - None
g

‘. Work Zero
2 1/2 Axis Pocketing (Upper)
2 1/2 Axis Pocketing (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

=]

4. Right-click and select Shop Documentation to display the dialog.
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BRI Machining Job

3 ME@ Regenerate All

35-5 Po - )

a Sto o Post All

@ F{[ simulete

=[5 Set

_". lL__k‘ Save to Knowledge Base

L li_‘-!) Information

(e .
= Shop Documentation %

o} Delete All

MILL Module shown, Similar for MILL-TURN, TURN
and Profile-NEST

5. Atthe bottom of the dialog, select the Output Template to use. The Excel Template will
display the Setup Sheet in a spreadsheet. All other template selections will display the

Setup Sheet as an HTMLL page.

L

This PC
¢ :
Network
File name: |how-to-create-aﬁetupﬁheet.l'rlm w | I Save
Save as type: Shop Documentation Files (" html;* xls) w Cancel

Output Template: | T ernplate

ExcelTemplate
T emplate]

Template3
Templated
Template_MOpList
Template_Stock

6. Enteraname forthe Setup Sheet and pick Save.

7. The Setup Sheet is generated and displayed. HTML pages are displayed in your default
web browser.
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Create a Tool

Cutting tools can be created anytime before during or after your create a toolpath. We have an

extensive guide just on cutting tools called The Cutting Tools Workbook that not only teaches you
about cutting tools but also provides worksheets for documenting the parameters you will need

from your existing tool bin to create those tools in RhinoCAM.

To create a cutting tool:

1. i3 To the left of the Program tab, select the Tools Machining Objects icon to make sure

the Machining Objects Browser is displayed.

MILL J:ﬂ Program Simulate & -8 @

y Machine a Stock ~ ‘. Work Zero 8‘-'.4Axis hd _‘_’%'
1% Post 88 nign - = 2 s - & 5 mis - R~
Setup ~ !E Material I\J: 3 Axis Adv ~ I—i,—IHoles hd

Machine Setup Stock Machining Operations

= Machining Job

2. Select the Tools tab from the Machining Objects Browser.

_rg Tools GRegions E%Features Ho K-Bases
T gRmeny oy g%y
I'_m Tools

3. J' Select the Create/Edit Tools icon (first icon on the left) to display the Create/Select

Tool dialog.
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Creste/Select Tool n

e g8 VHYEEHLILYVIEEBVENERREY

Took n Session

Holder Taper

| Properties Feeds & Speeds

Holder Material CARBIDE -
Holder Length | 1 1 |
Diameter | | Cut Matesal Color [T

‘ b~ ' || Mubes of Ftes
| | Tool Mumber

avl] w

Shank
Diameter

Shoulder

Length

2

1
Hdpast Fegister £
Cutcom Register |1
0

udal Difsat

il aln ale 4l

Flute .
Coolart  Morse w

Lengih
Coenfnerts
Tool Diarnater
Hame [Baiil
Shank Dia Tool Len Shoubder Len.
2 o ek
Flhite Len Tool Dia.
&0 2l |12
Holdei Dl Holdar s
Save az New Tool Save Edits o Too Dialete Tool
< > Concel Help
4, The top toolbar lists the supported cutting tools. Select the icon of the tool type you

want to create. The dialog will populate with the Tool type's parameters. For this
example we select the Ball Mill tool icon.

5. Editthe Name field to label your tool with a unique identifying name. Tools are stored by
their name.

6. Editthe dimension fields to define the tool's physical characteristics including the tool
holder, such as diameter length, etc. A preview of the tool will display in the dialog.

Narme |BaIIMiII1

Shank Dia.  ToolLen. Shoulder Len.
B

-

Flute Len, Tool Dia.
E0 =z =

Huolder | Drefault Halder b

7. Move to the right side of the dialog and select the Properties tab.

8. Here, make selections and enter values to define the tool's properties. Tool Material,
Number of Flutes, Tool Number, etc. are defined here.

© 2026 Mecsoft Corporation



RhinoCAM 2026 Q&A Guide

Properties  Feeds & Speeds

Material | HSS w

“

Cut M aterial Color

Mumber of Flutes 2 =
T ool Mumber 1 =
Adjust Reqister 1 =
Cutcom Register 1 =
£vial Offset E =
Coolant | Mare ~

9. Coolant type can be assigned to each tool also.

10. If you want a comment to be posted in the G-Code file when the tool is used, enteritin
the Comments field.

Comments

Fy Taol Comment goes Herel

11. Now select the Feeds & Speeds tab. Here you can assign all of the Spindle Parameters and
Feed Rates that you want this tool to use.

Properties Feeds 8. Speeds

Spindle Parameters

Speed 24448 = RPM

Direction @) Cw () COW

Feed Rates (indmin)

Flunge fpproach Engage
(22334 2] (148675 1 2

Cut Retract Departure
4EE7 S [11 2 [293M 2

Transzfer
(®) Use Rapid (O Set 29.33¢ 2

Feed Rate Reduction Factars

s

Plunge between levels | 100

First 37" pass 100

Cut Depth 0 = in

Laoad from File ...

A4

&

12. If you are unsure what values to use, you can select the Load from File button to display
the Feeds and Speeds Calculator dialog.
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Feeds/Speeds

Load Feeds from Tabla

D ata from T able

Stack Material
Tool Material
Surface Speed

Feed/Taath

|nput W ariables

WOoD
HSS
400

0.01

Tool Diameter; (0.5 = in
# of Flutes: |2 =

F amirurn Limnits for Compution

Mawx Spindle Speed
b aw Cut Feed

Computed Vanables
Spindle Speed

Cut Feed [CH

= fémin

10000

300

Ll (LA IR

RFt4

indmin

3055 [=]='¥]
CEE R

Cancel

Help

53

13. From here you will see that information about the Tool and Stock material are displayed.

See How to Assign a Stock Material for more information.

14. This dialog is a reference calculator that you can use to suggest spindle speed and cut feed

rates based on multiple parameters and variables. You will notice that changing
parameters and input variables in this dialog will update the Computed Variables section

at the bottom of the dialog including Spindle Speed and Cut Feed.

NOTE: This dialog is only used as a reference to calculate a suggested value for Spindle

Speed and Cut Feed. ALWAYS use values for these two parameters that are within
recommendations suggested by your machine tool vendor and your first-hand experience

with YOUR machine.

15. Pick OK when these two parameter values are to your liking for this tool.

16. You will notice that the values for these two parameter values Spindle Speed and Cut
Feed are then fed into the Feeds & Speeds tab of the Create/Edit Tool dialog.
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Properties  Feeds & Speeds

Spindle Parameters

Speed 3055 = RPM

Direction (@) Cw () COW

Feed R ates [indmin)

Flurige Approach Engage
|3u.5 O |45.?5 = |45.?5 O

Cut Retract Departure
[f1 2 7ees 2 a5 2

Transfer

® UseRapid (O Set 122 2

Feed Rate Reduction Factors

Flunge between levelz (100

First =Y pass 100
Cut Depth 1] =in

Load from File ...

17. You will also see that a percentages of the Cut Feed is used to populate the other Feed

Rate value in the Feed Rates section. These percentages can be defined in the Feeds &
Speeds section of the CAM Preferences dialog.

18. You can also adjust the Feed Rate Reduction Factors if desired.

19. When you are satisfied with your tool parameters, select the Save as New Tool button.

The new tool will be listed in the Tools in Session list on the left side of the dialog.

Create/5elect Tool

g 28 v agxLieo3 7 lNNF

BallMill - 142" 2FL-HSS e

Holder
Length

Shank

Diameter
Tool
Length

Shoulder
Lepath

20. If you make changes after saving the tool be sure to select the Save Edits to Tool button to

save your changes.

21. Now pick OK to close the dialog. You will see that the tool is then listed in the Tools tab

list of tools.
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J'g Tools GRegions %Features Ho K-Bases
T e & o7 gy
=] I'_m Tools

& EBalMil-1/2" 2FLHSS (—

22. o If you do not see your tool listed make sure the icon to List only tools used in
machining operations located at the bottom of the tools list is NOT enabled.

Mo Sort M +%+ s «

BallMill - 1/2" 2FL-HSS | #1 | Dia:0.5, CRack0.25, Taper:0 deg | RPM: 3055 | F

23. You can also create a tool from the Tools tab of each of the different toolpath operation
dialogs. From the Tools tab, just select the Edit/Create/Select Tool ... button to top
display the Create/Select Tool dialog again. See How to Generate a Toolpath for more
information.

[ Related Online Help Topics
User Interface
Tool

Create Edit Tools
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Create a Work Zero

When you zero your CNC machine for a job, you can tell RhinoCAM where this Work Zero location
is. Your G-Code coordinates will then be calculated from this location. You can also have multiple

Work Zero locations defined in your part. If no Work Zero is defined, then coordinates are
measured from the WCS origin of the part.

To Create a Work Zero:
1. Selectthe Program tab.

MILL | 'J3 Program Simulate & & @

8 Machine [ Stock ~ o WorkZero  Gegd ois ~ 37
1% Post 88 atign - | = 2 s ~ & 5 mis - -
Setup ~ 3= Material AJ 3 Axis Adv ~ l—i.—lHoles -

Machine Setup Stock Machining Operations
= Machining Job
Work Zero . .
2. ‘. Select Work Zero from the menu to display the dialog.
Work Zero >
Set Work Zero

(O Pick @ SettoStock Box () Set to Part Box
Zero Face

(®) Highest Z CiMidZ () Lowest 2

Zero Position
O Morthwiest (O Morth () Morth East
(O wiest () Center () East

® Southwest (O South () South East

>< Sy ems |2 z[oszms s [

lgnore Wireframe Geometiy in Part Bounds Computation

[ Output ‘whark Offset
Wiork Offset Register Mumber: 54 :

Cancel Save Help

Dialog Box: Work Zero
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3. You have the option to Pick the Work Zero location. Select Pick and then select the pick
button to select a point on the part. Its coordinates are populated into the dialog.

4. Optionally you can select Set to Stock Box and then select from the three available options
Highest Z, Mid Z and Lowest Z.

5. Then select the Zero Position. The nine locations to choose from.

6. Optionally you can also output the Work Offset Register. To do so, check the box to
Output Work Offset and then accept the 54 value or change it. This value will be posted to
your G-Code file as G54.

7. Pick OK and you will see the Work Zero added to the Machining Job.

In the example shown below the Work Zero is set to the Stock Box, Highest Z, South West.

=~ Machining Job
y Machine - 3 Axis
£ Post-Haas
[f; Stock - Box Stock
@ Fixtures - None
=& Setup1

‘- Work Zero|

Work Zero

[T] Related Online Help Topics
User Interface

Work Zero
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Define a Box Stock

You MUST define the Stock before creating a toolpath. There are different stock menu selections

to choose from depending on your software configuration. Here are the steps to create a simple
box stock.

1. Selectthe Program tab.

Program Simulate & F-8@

v Machine a Stock ™ ‘- Work Zero gﬁd:ﬂxis - 3’&-
15 Post Biaign - | Fomis - s - e
'{Z::' Setup ~ $= Material n:._; 3 Axis Adv ~ &Holes 5J
Machine Setup Stock

Machining Operations

=1 Machining Job

2. | a el | From the Program tab, select the Stock menu.
3. Select Box Stock to display the dialog.
Box Stock

Stock Geometry

Height (H)

Width (W)
ky Length (L) O
X

Corner Coordinates

X LU T

Dimensions

SNECH SIS R = CER =

-

Copy Madel Bounding Box

[ Igrore ‘Wireframe Geometry in Bounds Computation

Cancel Help

Dialog Box: Box Stock

4. The stock box will display on the part when this dialog is displayed.

© 2026 Mecsoft Corporation



Define a Box Stock 59

5. | Copy ModslBounding Box | 16 craate a stock with the exact dimensions of your part, select the

Copy Model Bounding Box button.

6. If you have curves or other non-part wireframe geometry displayed, you can check the box
in the dialog to ignore wireframe geometry in Bounds Calculation.

7. Alternately you can enter the Length, Width and Height dimensions of the stock you want
to use.

Dimersions
L e JF owizm [Ef oufee JH

| Copy Model Bounding Box |

[ Igriore ‘wireframe Geometry in Bounds Computation

8. Selectthe coordinate location to measure the stock dimensions from. By default stock
dimensions are measured from the bottom left corner of the part.
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9. You can also set the Corner Coordinates if desired.

10. Making changes in the dialog will update the stock preview on the part.

<o stockin Z Added [’

11. Pick OK to close the dialog.
12. You will see that the Stock is now defined under the Machining Job.

=~ Machining Job
3 Machine - 3 Axis
{2 Post- Haas
) Stock- BoxStock

@ Fixtures - Mone
ﬁ Setup 1

13. |%| The stock box will display on the screen. If you do not see the stock displayed, pick
the Toggle Stock Visibility icon located at the bottom of the Machining Browser - first icon

from the left.

A sler| o &F BBlK
Stock Visibility
B Toggle Stock Visibility

MK_M

k

[1] Related Online Help Topics
User Interface

Box Stock
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61

Before creating a toolpath make sure you have the Machine Tool definition set to the correct

Number of Axis and the axis directions defined.
1. Selectthe Program tab.

MILL iﬂ Program Simulate & S & @

‘y Machine a Stock ~ ‘. Work Zero g—'.ti,ﬂ\xis - HE-
1% Post 88 atign - | = 2. ~ @ 5 s - BR-
Setup ~ 8= Material l\_f, 3 Axis Adv ~ l—i.—lHoles -
Machine Setup Stock Machining Operaticns

=] Machining Job

2. y Maching From the Program tab, select Machine to display the dialog.
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Machine Tool Setup *

b achine Tool D efinition

© Manual Defirition (") Load From File
M achine Type
Mumber of Axes 5 Auis ~  Configuration Head-Head e

General Parameters
Tool Change Pt % |0 = |0 Sz =T

[ Output all coordinates in local Setup Coordinate System
Translational Lirnits

z[1om 2y
zhoo 2y

Mime % [-1000 w1000

Maw (1000 Yy | 1000

B Display Translation Limits

dth dmiz [Primary Awiz] Parameters

Fotary Center: % |0 =l S z|o =1
Rotary Auxis: % X + v @2 OZ
Rotary Asxis dnagle Limit W linit ~
Fatary Sxis Lirits [In Degrees]  Min |0 Maw | 360

Bth Az [Secondary Axiz | Parameters
w0 =l = l:@

Ratap sis: (e (O @+ O Z z

Fiota Center; 3 |0

Rotamy Axis Tilt Angle [Mutating Angle) In Degrees |0

Fokary Axis Angle Limit M linit “
Fotany dxis Lirits (In Degrees]  Min |0 Max | 360

[ Use az the Fotation Asis for 4 Asxis Machining Operations

Gage Length (For 4 & 5 &xiz Machines with 3 Rotary Head) : (10 =

Cancel Help
Dialog Box: Machine Tool Setup - Manual Definition
3. Fromthe Machine Tool Definition tab select Manual Definition.
4. For Machine Type, select the Number of Axis from the selection menu.

5. There are other General Parameters that you can set such as a Tool Change Point and
Translational Limits.

6. Checkthe box to Output all coordinates in local Setup Coordinate System. This is typically
check by default.

7. If Machine Type is set to 4 Axis, check the 4th Axis (Primary) Parameters section of the
dialog and make sure the Rotation Center and Rotary Axis direction are set correctly. An
axis indicator arrow ( ) will display on the part showing you this location and
direction. You can also set the Rotary Axis Limit here.
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Ath Auis [Primary Auiz) Parameters

Fiotary Center. ¥ |U = |U = |U =N
Rotary dais: @ +x O x O+ O +Z z
Rotary Axis &nale Limit | Mo limit ~
Fatary dxis Limits [In Degrees]  Min 0 S Max 360 =

W

8. If Machine Type is set to 5 Axis, check the additional 5th Axis (Secondary Axis) Parameters
section of the dialog and make sure the Rotary Center and Rotary Axis direction are set
correctly. An axis indicator arrow (Red) will display on the part showing you this location
and direction.

Ath Asis [Secondary Axiz | Parameters

Rotam Center; = |D

-

S
Rotaw fis: D+ O @+ O +Z z

Rotam Az Tilt Angle (Nutating Angle] In Degrees D

Rotary &xis Angle Limit o limit -

-

‘z|n

Rotam &xis Limits (In Degrees]  Min 0 S Max ZED =

4'

9. If Machine Type is set to 5 Axis and the parameter to Output all coordinates in local Setup
Coordinate System is NOT checked, make sure to set the value for Gage Length (For
machines with a Rotary Head). This represents the distance from the head's rotary axis to
the spindle face. This length value much match your machine in order for toolpath
coordinates to be output correctly.

10. Pick OK to close the Machine Tool Setup dialog.
11. You will that the Machine is defined under the Machining Job.

= Machining Job
3 Machine - 3 Axis
2 Post - AbilitySystems

@ Stock - None
ﬁ Fixtures - Mone

E’ Setup 1

[T] Related Online Help Topics
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User Interface

Machine Setup
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Define the Post-Processor

RhinoCAM installs with over 300 pre-defined post-processors for the most popular CNC machine
controllers.

1. Selectthe Program tab.

 Jee] -
MILL | "J3 Program Simulate & - 8@
38 Machine  [E)Stock ~ o WorkZero  Ogd s ~ 3§ 7
1% Post 88 atign - | = 2. ~ @ 5 s - BR-
Setup ~ 8= Material l\_f, 3 Axis Adv ~ l—i.—lHoles -

Machine Setup Stock Machining Operaticns
=] Machining Job
{;ﬁ' Post . .
2. From the Program tab, select Post to display the Set Post-Processor Options
dialog.
Select Post-Processor X

Select Post-Processor

Post-Processor type

(®) lse Legacy Post (0) Use Programmable Post

Select Post Processar

Current Post Processor | Haas ~ || Edit ...

Folder where post-processor files are located:
C:\ProgramD atabMecSoft Corporation’

Cancel Help

Dialog Box: Set Post-Processor Options

3. Select a Post from the Current Post Processor selection menu.
Select Post-Processor X

Select Post-Processor

Post-Processzor type

(®) Lse Legacy Post (0 Use Programmable Post

Select Post Processar

Current Post Processor: | AbilityS pstems w || Edit ..
Folder where post-proce: GSE218M f

G5K533M
C:\ProgramD ataiMecSd Haas-MM

Haas_with clag carnp-kdkd
Haas_with cut_comp
|' Handibot

ardipaa

Th

4. Each postin the menu has a corresponding post definition file (example: Haas.spm). The

location of these files is displayed in the field directly below the menu called Folder
where post-processor files are located.
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5. Make sure this points to the correct folder where your post definition file is located. To
change the folder location pick the ... button.

Select Post Processor

Current Post Processor: | Haas ~

Folder where post-processor files are located:

Edit ...

|E:\ProgramData\MecSoft Coarporation’,

&

6. RhinoCAM also comes with a Post-Processor Generator (PPG) that allows you to edit each
post definition file to suit your needs. Select the Edit ... button to the right of the Current

Post Processor selection to load that post into the PPG.

Select Post Processor

Current Post Processor: | Haas v k

Folder where post-processar files are located:

C:AProgramDatatkecS oft Corporation,

Post-Processer Generator  C:\PregramData’MecSaft Corporation’,

Stat/End File Contrad

Tool Charge

Setup

Spnde Fie Stat Resdng Cha | %
Feed Rate

Moton

Cirele [
HebostsSgital File Stop Resding Char [+
Mt 333 Mation
Cuttes Coempensation
Cut Moton 5tait/End

Sequence Hz
# Cycles “
Misi:
Vasiables [ e Smquence He
Frefoc Lettes |
Incremart 15
St wakoe 15
[ Show Leadng Zeios

Urats

@) Inch

) Metnc

Modal Dt

[ GCode
[ Coondrié

7. IMPORTANT: If you edit a post definition file included with RhinoCAM make sure you use
the Save As button from the PPG dialog and save your edited post using a unique file
name different than the pre-installed post name (example" Haas-REV1.spm) and save the
post definition file to a folder that is OUTSIDE of the RhinoCAM install path. This will
ensure that you will always have access to your modified posts even if RhinoCAM in

upgraded or uninstalled.
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ADutpud Erd of Block Character

7] GCode [ Feadiale (] Advrays cutput + sign

Tocednate £ Spindle speed A Show Leading Zesos
Cloge Save fs Help

8. Then, from the CAM Preferences dialog, select the Post tab and then drop down the
Posted File Extension list and select the file extension that is required by your cnc
controller software (example .nc). Your machine tool manual will tell you what file
extension is required. If your file extension is not on the list, pick the Add New ... button
to add it to the menu.

Preferences x
Geometry Pragram ta zend posted file ta
Features
C:\wWindowshhotepad.exe
Stock
Cutting Tools Faosted File Maming Corrvertions
Feeds & Speeds When a Machining Operation(z) iz zelected for Posting, use
M achining Fart File Mame-+tachining Operation Mame ~
Output Contral “when a Setup iz selected far Posting, use
Toolpath Part File Mame+Setup Mame e
Simulation

“When posting all in file, use
Uszer Interface Part File Name * -
[ b
Post

Lizenzing

9. If you use a G-Code Editor program, you can tell RhinoCAM to launch it when displaying
your G-Code files. By default, notepad is used to display G-Code files. See How to Post G-
Code for more information.

10. You can also set file naming conventions to use when posting your G-Code files.
11. When done pick OK to close the menu.

12. You will see that the Post is now defined under the Machining Job.
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- Machining Job
y Machine - 3 Axis
i Post-Haas
fjj Stock - Mone

ﬁ Fixtures - Mone
i;;‘ Setup 1

[ Related Online Help Topics

User Interface

Set Post Options
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Define Toolpath Properties

You can set the properties of a Operation by selecting it in the Machining Browser window,
clicking on the right mouse button and selecting the Properties menu item.

[T] Select Properties from the Right-click Menu

=1, Machining Job
Machine - 3 Axis
2% Post- Haas
@ Stock - Box Stock
@ Fixtures - Mone
=K Setup1
‘- Work Zero

I M'“"‘” .
@ Regenerate

-4

‘.:; Post
@ Simulate
Simulate Until
q,:’ Information
A NED
Rename
[ 4 Suppress
Vlb Cut
\E Copy
[3 Paste

Clone
lL__t‘ Save to Knowledge Base

Save As Defaults

j Properties

Select Properties from the Right-click Menu
Note: MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST
[T] Dialog Box: Machining Operation Properties

This will bring up the dialog that is shown below.
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Machining Operation Properties >

Program #: | |

Simulation Calor, [ ]

M arme: | 2

Comments to Output

Previouzly Dutput To File

| C:\ProgramDataihdecS oft Corporation’s |

Previouszly Output O
|Thursda_l,l, Maowember 03, 20 |

Cancel Help

Dialog Box: Machining Operation Properties

Name
Change the Name of the Machining Operation.

Program #
Specify Program # for the operation. This program number will be output during post
processing of the operation.

Simulation Color

This allows you to specify a unique color for this operation during Simulation display.
Refer to the Simulate tab Status Bar for setting the simulation to display by Mop (i.e.,
machining operation type).

Comments to Output

You can also include commands that will be saved with the operation. These comments
will also be output during post-processing of the operation. This might be a good place
to put in comments or instructions for the machine tool operator.

This can be used to put in add comments or instructions for
the machine tool operator!

Previously Output To File
This refers to the name of the external post-processed file that this particular operation
was output to.

Previously Output On
This refers to the last time the operation was post-processed and the time the post-
processing was performed.
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Edit Toolpaths Associatively

Machining Operations can be edited by using the Machining Browser. Each machining operation is
represented as a folder in the browser. In the expanded state of this foldericon, seven icons
representing different objects that make up the operation are displayed. The first five can be
associatively edited.

[T] The Machining Operation Tree Icons

The following icons are displayed under a machining operation's folder and represent
the different objects that make up the operation. The first five (Machining Features,
Tool, Feeds/Speeds, Clearance Geometry, Parameters, Toolpath Viewer/Editor and G-
Code Editor) can be associatively edited.

Machining Features
J’ Tool
3 Feeds/Speeds
E-[: Clearance Geometry
D Parameters
Toolpath

1 G-Code Editor

@ In-process Stock

[1] Double Click to Open a Machining Operations Dialog for Editing

Double clicking on the operation folder (or name) will open the operation's properties
dialog with all tabs displayed for editing.
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=~ Machining Job
y Machine - 3 Axis
Zz  Post - AbilitySystems
Ei Stock - Box Stock
@ Fixtures - Mone
= ﬁ Setup Bottom
‘.' Work Zero
| | Hole Pocketing
SRS 2 1/2 Axis Facing
Control Geometry
[ 45-55W_FaceMill_0.75
3 Feeds/Speeds
S Clearance

Parameters

Toolpath
b G-Code
'@ In-process Stock
| ] 21/2 Axis Pocketing

Double Click to Open the G-Code Editor module
Note: MILL Module shown, Similar for TURN and
Profile-NEST

1] Right or Double Click one of an Operation's Icons to Edit its Properties

Right mouse click or double clicking a specificicon, for example the Tool icon would
bring up the Tool Creation dialog, upon which you can substitute the current tool with
another or edit the parameters of the current tool.

Click on this Icon Displays the Operation's

Control Geometry tab

l'f Tool tab

Feeds/Speeds tab

1
ﬂ Clearance tab
B

Cut Parameters tab(s)

Toolpath in the Toolpath Viewer

r

Launch the G-Code Editor with the
latest posted g-code loaded.

'@ If flagged, simulate the operation.
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=BT

Machining Job

y Machine - 3 Axis

Zz  Post - AbilitySystems
ﬁ Stock - Box Stock

@ Fixtures - Mone

= g Setup Bottom

Note: MILL Module shown, Similar for TURN and

‘.' Work fero

| | Hole Pocketing
=) 21/2 Axis Facing

Control Geometry
il i 45-5SW_FaceMill 0.7

3 Feeds/Speeds
Clearance
S Parameters
Toolpath
%' G3-Code

'Eb In-process Stock
| | 21/2 Axis Pocketing

Right or Double Click one of an Operation's Icons to Edit

its Properties

Profile-NEST

[T] Drag & Drop a Tool from the Object Browser to an Operation

The tool can also be edited by dragging and dropping a tool from Tools tab to the
Machining Browser.
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&lﬂ Program Simulate & # & @
M Machine 6; Stock ™ e Work Zero 20 4 Axis ~ =

& Post 8 aign - 2 2ads v (@ SAxis T G -

£F Setup v #= Material | Al 3 Axis Adv gy Holes -

Machine Setup Stock Machining Operations

=-{, - Machining Job ~

3 Machine - 3 Axis
2%  Post - AbilitySystems
[Ei Stock - Box Stock

@ Fixtures - Mone

= g Setup Bottom

‘.' Wark Zero

| | Hole Pocketing

SRSl 2 12 Axis Facing

" Control Geometry

[ 45-55W_FaceMill_0.75
Feeds/Speeds

.- Clearance
. Parameters
; Toolpath

. %' G-Code

'@ In-process Stock v

B Jipg o &

) .
"fglols GRegions %Features %E K-Bases
TG & & Ty e Y
_. H' 2455w _VeeMil_&0 ~
2555w _Veetil_45
. H' B-55W/ Waehil_30
¥ 2755w Etch 45
,ll_ 4555 _FaceMil_0.75
%o J 6554/ _Flat-Short_0.125

&4 1455w Bal 0125
i 755w _FlatDown_0.0625

W a7 Filet i 0oRes <

Mo Sort ML -

6-55W_Flat-Short_0.125 | #6 | Dia:0.125, CRad:0.000, Taper:0.0 deg | RPM: 8000 | F: 16(

Drag & Drop a Tool from the Object Browser to an Operation
Note: MILL Module shown, Similar for TURN and Profile-NEST

[T] Display of Operations that need Regenerating after Editing

If any of the objects that make up the operation were to be edited after the toolpath was
initially generated, the operation will be flagged dirty (i.e., needing regeneration). This

condition is indicated by adding a red marker ? to the operation folder. Also, the
object that necessitated this condition -ﬂf is also displayed with a red marker.

An example of this is shown below. In this case the tool used in the operation was edited
after the machining operation was created and so is shown differently, as is the
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operation.

-4~ Machining Job
y Machine - 3 Axis
iz Post - AbilitySystems
[Ei Stock - Box Stock

@ Fixtures - Mone

=] g Setup Bottom

‘. Work fero

| | Hole Pocketing

i 2 1/2 Axis Facing
Control Geometry
' 6-55W_Flat-Short_0.125
Feeds/Speeds

% Clearance

Parameters

Toclpath
b G-Code

'@ In-process Stock

Display of Operations that need Regenerating after Editing
Note: MILL Module shown, Similar for TURN and Profile-NEST

Mops will be flagged if any associated parameters outside of the operation are edited.
For example, if the Stock is modified, any Roughing operations dependent on that Stock
will be flagged for regeneration.

=1, Machining Job
y Machine - 3 Axis
Zz  Post - AbilitySystems
S <
@ Fixtures - Mone

= g Setup Bottom

‘.' Work fero

= ? Horizental Roughing

% Control Geometry
- [ 1-5SW_Flat-Short_0.25
Feeds/Speeds

% Clearance

Parameters
Toolpath

¥ G-Code

'@ In-process Stock
Note: MILL Module shown, Similar for TURN and Profile-NEST

[T] Regenerating "Flagged" Machining Operations

© 2026 Mecsoft Corporation



76 RhinoCAM 2026 Q&A Guide

In order to regenerate the operation that is flagged with a red marker, you would have to

select the operation, right click and select Regenerate.

=-{, - Machining Job
y Machine - 3 Axis
2  Post - AbilitySystems
[Ei Stock - Box Stock

@ Fixtures - Mone

= 3 Setup Bottom

‘. Work fero
G

Cuntruli‘ﬁ Regenerate
5
[ 1-sswF % Post

3 Feeds/Sp
S Clearanc @ Sirnulate
Paramet, Simulate Until

Toolpath

B G Code Simulate To End
@ In-proce ';I,:J |Information

Right-click on an Operation and Select Regenerate
Note: MILL Module shown, Similar for TURN and Profile-NEST

The toolpath is now generated with the modified settings.

-4, Machining Job
y Machine - 3 Axis
22 Post - AbilitySystems
Ei Stock - Box Stock

@ Fixtures - Mone
= 3 Setup Bottom
‘.' Work Zero

Control Geometry

[ 1-5SW_Flat-Short_0.25

3 Feeds/Speeds
Clearance

S Parameters
Toolpath

b 3-Code
'@ In-process Stock

Machining Operation is Regenerated
Note: MILL Module shown, Similar for TURN and Profile-NEST
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Enable Cutter Compensation

All toolpaths except engraving are automatically compensated for the tool geometry. Cutter
compensation is used typically to compensate for the difference in the dimensions of the actual
cutter used in machining and the cutter used for programming in RhinoCAM. For example, if the
cutter used in programming is 0.25 inches and due to tool wear the actual cutteris only 0.24 inches
in size, you can compensate for this at the controller rather than having to re-program the
operation in RhinoCAM.

Cutter compensation is used extensively in production (high volume) machining where the
machine operator can compensate for tool wear before having to stop and replace the tool or
insert.

In order to do this the user needs to do the following:
1. Turn cutter compensation on in the operation to Auto/ON or CONTROL/ON.

2. Specify the cutter compensation value and the compensation register in the controller
(the controller needs to be capable of doing this).

3. Please make sure the post processor is configured to output cutter compensation. This is
defined under the Cutter Compensation section in the post processor generator. Most
controllers expect an X & Y motion on the same line as cutter compensation.

Cutter Compensation Left

[SEQ_PRECHAR][SEQNUM] G41 [G_CODE] X[NEXT_NONMDL_X] Y[NEXT_NONMDL_Y] D[TOOL_CUTCOM_REG]
Cutter Compensation Right

[SEQ_PRECHAR][SEQNUM] G42 [G_CODE] X[NEXT_NONMDL_X] Y[NEXT_NONMDL_Y] D[TOOL_CUTCOM_REG]
Cutter Compensation Off

[SEQ_PRECHAR][SEQNUM] G40
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Post-Processer Generator x

Germral

Stat/End Cuatter Compensation Laft

;z:-h"‘?‘ [SEQ_PRECHAR|[SEQNUM] G41 [G_CODE] XNEXT_NONMDL_] YINEXT_NONMODL_Y)D[TOOL_CUTCOM_REG)
Spinclle

Feed Rate

Mation

Cicle

Habeal'Spial

Il Axiz: W otion
ICutter Compenabion ﬁ
Cast Mobion Stat/End ¢ Curer Compenzation Right

#- Cycles SEQ_PRECHAR[SEQNUM) G42 [6_CODE] <INEXT_NONMDL_X] YNEXT_NONMOL_Y¥) D[TODL_CUTCOM_REG)

Misc
Wariable:

Custter Compenzation OIff
|SEQ_PRECHAR)SEQNUM] G40

Save Close: Save Az Help

A few things to watch out for:

1.

Cutter compensation makes sense only in 2-1/2 axis operations. If you are using roughing
(pocketing & facing) the compensation will be turned on only in the final passes.

Make sure you are using Climb or Conventional cut traversal in any of the methods that
you want to turn compensation on.

2 1/2 s Profiling X

CutLevel:  Entm/Exit  Adwanced Cut Parameters  Cornering Parameters Sorting
Control Geometiy Tool Feeds & Speeds Clearance Plane Cut Paramneters

Global Parameters

Region
Tolerance: |0.001 = 0
L/ Toolpath
. - ,'*-\.
Stock: |7 = /" Tolerance

Carmpensation:
Compensation refers to cutter compensation. You can turn

(AUTO/NONE | s ;
NE this on by selecting from the drop down menu. The cutter

COMTROL/ON compensation direction, left or right, is determined by the Cut
Direction defined (Climb or Conventional). Refer to Cutter

Compensation for additional information.

Cut Direction
(®) Climb [Doven Cut)

(0) Corwentional [Up Cut)

() Mized

Cut Start Paint for Closed Curves

Usze Mid-Paint of longest side

3. Make sure you have a linear motion for the controller to turn on the compensation for. If

your first motion is an arc the controller will not be able to turn on the compensation.
Thus, in 2-1/2 axis profiling, make sure there is a linear entry motion for the controller to
be able to turn compensation on & linear exit to turn off compensation.
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If you are looking to compensate for the full tool diameter, set Stock =-0.125 under the cut
parameters tab. (0.125 being the radius of the tool). This would generate the toolpath ON the
curve. This would invalidate the simulation as the tool tip stays on the drive geometry.

Note: The Cutcom Register is set under the Create/Select Tool definition dialog.

Properties  Feeds & Speeds

Material | CAREIDE ~

I

Cut Material Color

=

Mumber of Flutes

—y

Tool Mumber

Adjust Register

"y

5 0

Cutcom Register

Aial Offzet 0

la ane
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Enable Inverse Time

Feedrate in 4 Axis

You do not need to edit your toolpath operations to output the Inverse Time Feedrate format! It
is done automatically once it is enabled in your post processor. Follow these steps to enable the
Inverse Time Feedrate format in your post:

1. From the Program tab under Machine Setup, select the Post icon to display the Set Post-
Processor Options dialog.
2. For Current Post Processor, select your post.
3. Pick the Edit button to the right. This will display the Post-Process Generator dialog.
MILLI'IB Program | Set Post-Processor Options x
3 Machine £ Set Post-Processor Dptions
i Post
57 Setup Post-Processzor type
(®) se Legacy Post () Use Programmahble Post
Machine Setup St
3 Machine Select Post Processar ol
7z Post-Ha Current Post Processor | Haas ~ || Edit...
@ SFMk -B Falder where post-processar files are located:
@ Fixtures - [Pame sData\ecSoft ComorationtPRhivcCAM 2018 fo
Launch the Post-Process Generator
4. From the left side pane, select the Feedrate section.
Genetsl
Stt/End Black Fomat
Taol Charge Feed Rate Code F EA Add after Hest Motion Code Irvverse Time Fead Rabe
Selup
Spindle ] Outpust irveese: tirne feeckate for 4 & 5 Auas motians
Feed Rate FeuedeeMo-desl ) i . )
Miotion Units/Min Code: Uritz/Riev Code: O Code 0if Code:
Citcle J [ |
Hebcal/Spieal
Mk s Motion Elock Fomat
Cuttes Comnpanation
Cut Mition Stat/End FIFEEDRATE]
4 Cythes
Mz Sampls Olutput Celad
Wasiables |Fﬂ
Feed Rate Vahe
HighVaiue | 3001 ScaleFacter | 1% ZFeedfiste ScaleFactor | 113
Low Vislue 15 #otDecmalPloces | 3% Show Traling Zeeor [
Argulsr Feechste Vi
ScasFactor [ 112 #oiDecmalPlaces | 115 Show Traling Zeies [

Close SaveAs., Help

Post-Process Generator / Feedrate / Inverse Time

5. Ontheright side pane, under Block Format, check the box next to "Output inverse time
feedrate for 4 & 5 Axis motions".

6.

For On Code, enter G93.
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7. For Off Code, enter G94.

8. Pick Save As to save your (*.spm) post.

Anytime you make an edit to your post (*.spm) file, it is recommended that you
select Save As to save your post file to a unique name and to a unique folder where
you can find it (such as your Desktop or shared Network Drive).

o

9. With your revised post set as your Current Post Processor, pick OK to close the Set Post-
Processor Options dialog.

y Ifyoudonotsee yourrevised postin the Current Post Processor list, select the "..."
button to the right of "Folder where post processor file are located" and navigate to
the folder where you save your post (*.spm) file. It should then appear in the list.

10. Test the revised post with a sample 4 or 5 Axis toolpath operation.
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Estimate Machining Time

You can calculate the estimated machining time for one or more toolpath operations. The time is
calculated based on the Cut Feed and Transfer Feed rates assigned to each operation. Understand
that the machining time is an estimate. It does not take into account any physical or limiting
factors of your CNC machine or controller settings. See our blog article Optimize Machining Time

Estimates! for additional reading.

To calculate the estimated machining rime:

1. Create and adjust the toolpath operations that you want to estimate.

2. Make sure the toolpath has generated cleanly. Each toolpath when generated is listed
under a Setup in the Machining Job. If the operation is flagged it means that it needs to be

regenerated.

= Machining Job
y Machine - 3 Axis
iz Post-Haas
@ Stock - Mone
Fixtures - Mone
=--Fi& Setup 1
i ‘. Work Zero
2 1/2 Axis Pocketing (Upper)
2 1/2 Axis Pocketing (Lower)

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Select the operation that you want to estimate. You can select multiple operations by
pressing the <Ctrl> key while selecting. You can also select an entire Setup or the entire

Machining Job.

=] Machining Job
y Machine - 3 Auxis
22 Post- Haas
@ Stock - Box Stock

_@ Fixtures - Mone
5 ]
‘. Work Zero

2 1/2 Axis Pocketing (Upper)
2 1/2 Bxis Pocketing (Lower)

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

=]

4. Right-click on the selected operation(s) and select Information to display the dialog.
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=1~ Machining Job
y Machine - 3 Axis
s Post-Haas
a Stock - Box Stock

@ Fixtures - Mone

Setup 1

Bt

=l

‘. ],ﬁ Regenerate
o ]

EH-E

L
l. | 5 Post

Simulate
’-!-\ Information
e N

I Shop Decumentation

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

5. Each selected operation is listed. The estimated machining time is shown in the right side
column along with the total time for all listed operations.

Machining Operations Information

x
Mops Information

Hame Status Toal Tool ®  Cut Feed 2of GOTOs Machine Time
Sebup 1

W Zero Clean Mo Tool - 0o

2 172 Pais Pocketing (Up_.. Clean FLATMILL-.. 2 40,00 infrmin 1629 10021 min

2 1/2 Fois Packeting (Lo... Clean FLATMILL-.. 2 40.00 in/min 2759 841 min

Senp-total 1862 min
< >
Prirt

o[ comea || wew

6. Selectthe Print button to print the report if desired.

7. Pick OK to close the information dialog.
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Find Tool Related Preferences

Listed below are the CAM Preferences that are related to Tools and Tool Libraries:
1. Locate the CAM Preferences icon to the right of the Program tab and select it.

2. Select the User Interface item from the left. Here are a couple of Preferences that will
help you with the tools related dialogs:

Show context ToolTips

Check this box to display Context ToolTips when the mouse moves over a parameterin a
dialog. A definition of the parameter will pop-up automatically. Note that Context
ToolTips may not be available for ALL dialogs. You can also set the ToolTip Delay in
seconds. This is the amount of time it takes to display the Context ToolTip when the
mouse activate it.

b1 Jrsts ]
.zﬁ(ﬂ,. 125 = T e

D

% Tool Diameter allows you to set the stepover
distance for the cumrent operation as a

percentage of the active tool diameter
r Olrade O Ousde  Dorrrr o
L Abvess B Tiood Diown

Show Expressions in Tooltip

You can enter expressions in any dialog field that expects a numerical value and the value
will be computed and entered automatically. Check this box to pop-up the results of any
expressions in a ToolTip balloon. An example is shown below.

Laocation of Cut Geomnetry
(Ot Top (@) 4% Bottom

OPick Top |0 Y
Cut Depth Control
Tatal Cut Depth:

Rough Depth:
05 =

-

Show Expressions in ToolTip

3. Select the Cutting Tools item from the left.
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Preferences

85

Geometny
Features

Stock

[ Cutting Toolz

Feeds & Speeads
tdachining

|| Output Cantral
Toolpath
Simulation

Uszer Interface
Fost Processar

Lizenzing

Cutting Tool Colors

Tool Flutes I:l - Tool Shank. - -
Tool Halder - -

Tool Dizplay
O5olid (O Transparent () 'Wireframe () Mone

@ Display Tool Holder

Tl Library Preferences

B &lways load last lnaded taol library on startup

Default Tool Library

Clear

Fieset to defaults

Cancel Apply Help

CAM Preferences > Cutting Tools

Note: Menu selections on the left may change depending on module and

configuration

4. You can select the Default Tool Library to load for new part files. You can also check
the box to Load the last loaded tool library on startup. This will ensure that your Tool
Library loads every time the program runs.

You can also set Tool related colors on this dialog.

Now select the Feeds & Speeds section from the left.

Here you can decide if you want default Feeds & Speeds loaded from the Tool for new
operations. If you set this to Tool and define your Speeds & Feeds for each of your

tools, you can be sure those Feeds & Speeds are being used when a new operation is
created that uses that tool.
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Preferences *x
| Geametry Load Feedrates for new operations from
|
|| Featues © Tool () Feeds & SpeedsFile () Defaults
Stack
| . % 5 to use for ansferning from computed cut feed
Cutting Tools
100 L.
Feeds & Speeds ] Cut Feed (L) - | = v
-]
[ Machining Purge(F) 80 = Cutstart . H

1
i

»
ol

¥
Cutput Control Appraach [Af) Af
z Clearance
Toolpath
nopa Engage [Efl 75 = (J szf

le
K
Df

|
I

Rf

“
o

Simulation

o

Retract [Rf] 125 -
Uszer Interface x

a0
Q

Post Processar Departure (D] 150 =

Lizenzing Transter [Tf) 200 =

23

Feedsz/Speeds Tracking Options
() Always track Operations Feeds/Speeds to used Tool

Rezet to defaults Cancel Spply Help

CAM Preferences >Feeds & Speeds

8. You can also set the % of the computed Cut Feed to use for the various types of
transfer motions. For example, in the Feeds & Speeds Calculator (displayed when you
select Load from File from either the Create/Select Tools dialog or from the Feeds &
Speeds tab of any operation type) a Cut Feed value is calculated and suggested.
These percentages listed in this CAM Preferences dialog will determine how much of
that Cut Feed value is used for each of they remaining tool motion types.

9. You can also check the box to Always track Operations Feeds/Speeds to used Tool.
When this is checked, changing the feeds/speeds parameters of a tool and saving the
edits, will automatically update the feeds/speeds on each operation that utilizes this
tool in addition to marking the operations as dirty.

=l Machining Job
3 Machine - 3 Axis
t%  Post- Haas
a Stock - Box Stock

@ Fixtures - None
=% Setup1
e Work Zero
*| Horizontal Roughing
; Parallel Finishing
| ] 21/2 Axis Profiling
/% Setup2
e Work Zero
g Harizontal Roughing

#| Parallel Finishing
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Generate a Toolpath

RhinoCAMincludes many toolpath operation types to choose from depending on your software
configuration. Also each operation type has default parameters predefined to allow you to
quickly create a toolpath and view the results.

Here are the basic steps to create a toolpath:

1. Open a part or drawing file or create the geometry that your wish to create a toolpath for.
2 Axis operations can be created with 2D or 3D geometry. 3 Axis operations require
surface and/or mesh geometry. Some 4 Axis operations require 3D solids or surfaces only.
All and 5 Axis operations require 3D solids or surfaces only. You must have visible
geometry in your part file to create a toolpath.

In this example we will generate a 2 Axis Pocketing toolpath to machine the bottom
pocket in this 3D solid model.

2. Perform the steps needed to setup your part. These include defining your Machine, Post
and Stock. You must first have geometry and Stock defined to create a toolpath.

Work Zero

3. Select the Program tab.

Program | Simulate o g -8 @

3 Machine a Stock ~ ‘- Work Zero g‘-:dﬁ\xis - 2&'
25 Post @mign - | = 2 s - fé}esnxis - Bg.
'1:3:=' Setup ~ = Material I\LJ, 3 Axis Adv ~ ﬁHoles -
Machine Setup Stock Machining Operations
=4 Machining Job

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST
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4. Decide what type of toolpath to create and select the operation type from the menus on
the Program tab. Depending on your software configuration, you can select from the 2
Axis, 3 Axis, 4 Axis or 5 Axis menus. The operation dialog for that toolpath type will
display.

'—J’ 285 17 Eor this example we will generate a 2 Axis Pocketing toolpath so select the 2
Axis menu.

=]

6. el Select Pocketing from the menu to display the dialog.

2 1/2 fxis Pocketing X

Cut Parameters  Cut Lewvels  Pocketing Entry/Exit Advanced Cut Parameters  Sorting
Cantral Geometry Tool Feeds & Speeds Clearance Plane

Fart Regions  Awoid Fegions  Start Paints

#  Selected Machining Region(z)

£ >

Move Up | il Move Down

> Remave sl | 2 Remove Active

[Q Select Curve/Edge Fegions
Select Surface Boundary

Ry Select Flat Area Regions
[-Q Select Pre-Defined Regions

Cancel Save Help

7. The dialog has several tabs at the top. The Control Geometry tab is displayed first. Use it
to select your machining regions. All 2 Axis operations require that you select machining
regions. In 3 Axis and 4 Axis operations machining regions are used to if you want to
contain the toolpath but are not required for all 3 and 4 Axis operations. 5 Axis operations
do require machining regions.

8. The buttons on this tab are used to select your machining regions. Here we will pick the
Select Flat Area Regions button.
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Ly Select Flat Area Fegions

9. The dialog minimizes and you are prompted to select a flat area. We select the bottom of
the inner pocket and then right-click or press <Enter>.

10. The dialog reappears with the selected machining regions listed. They are also
highlighted on the part.

2 1/2 Axis Pocketing X

Cut Parameters  CutLevels  Pocketing Entrp/Exit  Adwanced Cut Parameters  Sarting
Cantral Geometry Tool Feeds & Speeds Clearance Plane

Part Regions  Awvoid Regions  Start Points

#  Selected Machining Region(z)
1 DniveFlat Area

There are other ways to define and select machining regions. You can pick Help from the
dialog to learn about each button option.

11. Select the Tools tab and select a tool from the Tools list or select the Edit/Create/Select
Tool ... button to create a tool. You must select a tool to create a toolpath.
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2 1/2 Pxis Pocketing

Cut Parameters  Cut Levels

Control Geometiy Taool

Packeting Entry,/E xit

Feeds & Speeds

*

Advanced Cut Parameters  Sorting

Clearance Plane

=] I'_m Tools
A FLATMILL1 /2 INCH

FLATMILL-1/4 INCH

FLATMILL-1/8 INCH
FLATMILL-3/4 INCH

BALL* A gy

SR

B Tool Geometry
Diameter

P
L

Corner Radius

Taper

=3~~~

Tip Angle
B Tor! Properties

12. Select the Feeds & Speeds tab and set the Spindle Speed and Feed Rates for the operation
and use the Load from Tool ... or Load from File ... buttons. The Load from File ... button
displays the Feeds & Speeds Calculator to assist you will selecting feeds and speeds

values for the operation.

2 1/2 Axis Pocketing *
Cut Parameters  CutLevels  Pocketing Entrp/Exit  Adwanced Cut Parameters  Sarting
Control Geomety Tool Feeds & Speeds Clearance Plane
Spindle Parameters

Speed PassE = RPM ﬂ

Direction @ow (oW L]

Pf
Feed Rates Cut Start Y
= Clearance Af
Plunge [Ff) 2333 = indmin Plane
Spproach &) |T46E7 == infmin (J /Ef
Engage [Ef] 1" = infmin -
Cut [Cf] 14667 2 intmin
Retract (R |11 = in/min kct
Departure [Df) |29.334 indmin D
Transfer Tl (@) Use Rapid () Set _ETJ
28334 indmin

Feed Rate Reduction Factars Coolant
Plunge between levels 1oa = = MHone ~
First 3 pass 100 =1
Bottomn £ Level 100 =S4

Load fram Taool Load from File ...

Cancel Save Help

13. Select the Clearance Plane tab and adjust if desired.
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21/2 Axis Pocketing X

Cut Parameters  Cut Lewvels  Pocketing Entry/Exit Advanced Cut Parameters  Sorting
Contral Geornety Toal Feeds & Speeds Clearance Plane

Clearance Plane Definition
Clearance Plane

(®) Automatic
(O PatMaxZ +Dist 025 2
() Stock Maw 2 + Dist 0.25

(O Absolute ZValue 025 2 Part Max Z

-

lgnore ‘wireframe Geometry in Bounds Computation

Cut Transfer Method

Clearance
() Skim Plane

Skim Clearance [C] |0

(®) Clearance Plane

14. Now we will select the Cut Parameters tab of the dialog and make the following
adjustments. Stock will leave 0.01 remaining on the side walls. The cut pattern will offset
the perimeter of the pocket. The cut will start in the middle of the pocket, offset outward
at a stepover 0.01 and perform a cleanup pass at each cut level.

Tolerance : 0.001

Stock : 0.01

Cut Pattern : Offset

Cut Direction : Climb

Start Point: Inside

Stepover Distance : 0.12
Corner Cleanup Loops : None
Cleanup Pass : Checked
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2 1/2 fxis Pocketing X

Control Geomety Tool Feeds & Speeds Clearance Plane
Cut Parameters  CutLewels  Pocketing Entr/Exit  &dvanced Cut Parameters — Sorting

Global Parameters ’
Region

Talerance: |0.001 = " 5
Toolpath
. = T
Stack: hd * Tolerance
Compensation: |AJTO/MONE o T stock

Cutt Pattem
(® Offset () Offzet Spiral (O Linear () Spiral () Radial () High Speed

Cut Direction

(®) Climb [Doven Cut)

() Corventional [LUp Cut)
() Mized

Start Point b
(@) Inzide () Outside

h

Stepover Distance

() % Tool Dia. 25

(®) Digtance

Corner Cleanup Loops

@ MNone  Olnside (O Outside

e
T

Ak 4w

-+ W Stepover Distance

Cleanup Pass
[ fdwayz Keep Tool Down

15. Next we select the Cut Levels tab. All 2 Axis operations require your to adjust the Cut
Levels tab to control the depth of cut. In all 3, 4 and 5 Axis operations your part surfaces
will l[imit the maximum depth of cut.
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2 1/2 fxis Pocketing X

Control Geomety Tool Feeds & Speeds Clearance Plane
Cut Parameters  CutLewels  Pocketing Entry/Exit  Advanced Cut Parameters  Sorting

Location of Cut Geometry
@At Top () At Bottom

. D -
() Pick Top = [% Rough Cut Geometry at Top
Depth
Cut Depth Contral T r _E Rough
_ Total f—. —— Depth/Cut
Total Cut Depth: El =T Cut —a— 1
Depth = EEini
Fough Depth: Finizh D epth: Finish Finish

= = Depth/Cut

Faugh Depth/Cut E = Finish Diepth/Cut: E =

[ Clear Island Tops [JUse 3D Model to Detect Depth
Cut Levels Ordering 'l\r

(®) Depth First § —é é

() Level First — 3

16. First make a selection to define the Location of Cut Geometry. In our example we select
At Bottom because the machining regions we selected lie at the bottom of the pocket. If
they lie at the top we would select At Top. If they do not lie either at the top or the
bottom of the pocket you can use the Pick Top option to define the top of the cut.

Lacation of Cut Geometry
O atTop (@ At Botom
OPickTep 0 R

17. Next we move to the Cut Depth Control section. If you know how deep the pocket should
be just enter the depth in the Total Cut Depth field. This is always an absolute value (i.e.,
no negative numbers).

Cut Diepth Control

Total Cut Depth: El : I

Fough Depth: Finizh D epth:
o - |El | -

- -

18. L In our case we do not know the exact depth without manually measuring the
geometry so we will select the Pick button.
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19.

20.

21.

22.

23.

The dialog minimizes and prompts us to select s start point and an en end point to define
the Total Cut Depth. We select the top and bottom floor of the pocket and then right-click
or press <Enter>.

The dialog reappears with the Depth of Cut calculated for us.

Cut Depth Cantral

Tatal Cut Depth: =

Fough Depth: Firizh D epth:
016eeE7| 2 [0 |2

-

Notice that the value in the Rough Depth field is now the same as the Total Cut Depth.
You have the option to split the Total Cut Depth into a Rough Depth and a Finish Depth.
We will enter 0.05 into the Finish Depth field and then press the <Tab> key (or simply
activate another field.

We see that the Rough Depth value is now reduced by 0.05. The Rough Depth and Finish
Depth values will always equal the Total Cut Depth value. You can also use the slider to
split these values up.

Cut Depth Cantral

Tatal Cut Depth: =T

Fough Depth: Firizh D epth:
oieee?| s [oos |2

You will also notice now that the Rough Depth/Cut and Finish Depth/Cut fields are
populated with the save values. If we generate the pocket toolpath right now, there
would be one rough level cut and one finish level cut.

Fiough Depth/Cu: = Finish Depth/Cut: =
| [ |
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24. We can add additional cut levels by entering 0.03 in the Rough Depth/Cut field and
entering 0.01 in the Finish Depth/Cut field. This will produce 4 rough cut levels at the top
of the pocket and 5 finish cut levels at the bottom of the pocket.

Fiough Depth/Cut: =

Firish Depth/Cut: =

25. With our cut levels defined we select the Pocket Entry/Exit tab of the dialog.
2 1/2 fuis Pocketing X
Control Geometiy Tool Feeds & Speeds Clearance Flane
Cut Parameters  CutLevels  Pocketing Ente/Exit  Advanced Cut Parameters  Sorting

Entry Motions
Appraach Mation
Length[L) [0.025 |=
Engage Maotion LE e~ i
OPath Angle [4) 5 - >
(O Linear  Height [H] = g6
Distance (D) 0.05 =
(®) Helix Radius(R) |0.0625 |-
Exit Mations

Fietract Mation

@ Linear  Length (L] (00825 [

() Radial Raduz(R] 0

Rapid +

Departure

Departure Motion

Vertical Dist (D) [0.025 [

Apply entrp/exit at all cut levels

26. Now we select the Pocketing Entry/Exit tab to control how the cutter will enter and exit
the part and make the following selections:

Approach Motion Length (L) : Default (0.025)

Engage Motion : Helix

Helix Radius (R): Default (0.0625)

Retract Motion : Linear, Length: 0.0625, Angle (A): 45
Departure Motion : Vertical Distance (D): Default (0.025)
Apply entry/exit at each cut level : Checked
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2 1/2 Pxis Pocketing

Contral Geometmy Toaal

Approach Motion
Length (L] [0.025 |2

Engage Motion

OFPath  Angle (4 |10 <
(O Linear  Height [H]{0.05 =

Distance [D] 0.05 =
@ Helx  Radius(R) =

Retract Mation

@ Linear  Length (L) =
Angle [4] D

() Radial Raduz(R] 0O

Departure Mation

Vertical Dist D) [0.025 |-

Apply entrpdexit at all cut levels

Feed: & Speeds
Cut Parameters  Cut Levels  Pocketing Entr/Exit

pld
Refract—" A\ .
A S

Clearance Plane
Advanced Cut Parameters Sorting

Entry Mations

S
O
A

L

H

E it Motions
Rapid +

Departure
SN

27. Now we will select the Advanced Cut Parameters tab and make the following selections.
The parameters available on this tab will depend of the type of toolpath operation and

your software configuration.

Perform Arc Fitting : Checked
Fitting Tolerance (t) : 0.002

Use Smooth Cut Connections : Checked
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28.
29.

30.

2 1/2 fxis Pocketing X

Control Geomety Tool Feeds & Speeds Clearance Plane
Cut Parameters  CutLevels  Pocketing Entry/Exit | Advanced Cut Parameters | Sarting

Cut Corner Rounding Options < (‘ ]
T
[ Pesrform Cut Rounding ) r

= N T
Fiounding Fadius 1] 01 S \

Cut Are: Fitting .
Perfarm Arc Fitting ﬁ
/
Fitting Tolerance [t) 0.002 = |

Smooth Cut Transitions

Use Smooth Cut Connections

With these selections full and partial arc motions will be generated within the Fitting
Tolerance (t) we have specified. There will also be smooth cut connections between
stepover paths. These advanced parameters will reduce the torque stress on your CNC
machine and also reduce tool deflection, prolonging tool life.

Since we only have one pocket we do not need to look at the Sorting tab.

Now were ready! Select the Generate button at the bottom of the dialog to generate the
2 Axis Pocketing toolpath and display it on the screen.

% Generate Cancel Save Help

Itis also listed in the Machining Job.
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= | Machining Job

-3 Machine - 2 Axs
{2 Post- Haas
@ Stock - Box Stock

a Fixtures - None

31. M If you do not see the toolpath displayed, select the Toggle Toolpath Visibility icon

located at the bottom of the Machining Browser.

32. Let's have a closer look at the toolpath.

Helical Engagement
at each Cut Level

Offset Cut Pattern

O —% o [ O
Smooth Cut
Connections

&

& ﬂ

() Fitting (] [0] /O

[#] =

v

Depth/Cut

T Rough Depth

R

Finish Depth

“ !
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Load a Tool Library

You can have multiple tool libraries saved. This is useful when archiving tools by type or by stock
material, etc. You can then load atool library at any time.

1. 3 To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.
MiLL | Program Simulate o -8 @
39 Machine [ Stock ~ o WorkZero  Begd Aois ~ J& 7
%5 Post @Angn - | = 2 s - ffsAxis - Gg.

=::= Setup ~ ;E Material l\; 3 Axis Adv ~ I—‘£—|H0|E5 hd
Machine Setup Stock Machining Operations

= Machining Job

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

2. Select the Tools tab from the Machining Objects Browser.

J'g Tools GRegions %Features He K-Bases
T aBae s o e Ky
Itm Tools

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3. @f Select the Load Tool Library icon to display the Open dialog.
4. Navigate to the folder where your tool library file is saved. Select the file and pick Open.

5. You will see a message alerting you that tools are being loaded from a library. Pick OK and
all tools in the library are loaded into the current part file and the tools are listed in the

Tools list of the Tools tab.

| 15 tool(s) successfully loaded from library.
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6.

J'g Tools GRegions %Features Ho K-Bases
v (Gl o vy

=2 I'_m Tools

@ BalMil-1/2" 2FLHSS
& FLaTMILL1/2INCH
& FLATMILLA/4INCH

i FLaTMILLA /8 INCH

B FLaTMILLa/ INCH +
& BaLLMILL-1/2INCH
& BaLLMILL-1/4 INCH
&2 BeLLMILL1/2INCH

¥ TE"DEG

-

-

-

If you have tools already created in this part file they are not removed. The tools in the

library are just added to your Tools list.

© 2026 Mecsoft Corporation



Load a Tool Library Automatically| 101

Load a Tool Library Automatically

If you have a Tool Library file saved and you want this tool library to load each time you create a
new part file:

1. First make sure you have a Tool Library saved. See How to Save a Tool Library for more
information.

& Select the CAM Preferences icon located at the top-right of the Machining Objects
Browser (i.e., to the far right of the Program tab) to display the dialog.

MILL |3 Program Simulate & - @

f=
8 Machine Q) Stock +  of® WorkZero B4 Auis + &7
2% Post Align ~ | =7 2 Axis ~ B 5 pvis PR
: © , 4
-5 Setup * !: Material l\_f, 3 Axis Adv ~ |_£—|HDIE5 *
Machine Setup Stock Machining Operations

=1 Machining Job

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3. Fromthe left side of the dialog select Cutting Tools.

Preferences x
|
| Gieometry Cutting Tool Colars
|
Features ToolFlutes [ | = ToolShank [N -
Stock
| ) Tool Hold -
Cutting Toolz ] oo Holder -
Feeds & Speeds .
F Tool Dizplay
| tdachining ) :
O 5oid () Transparent O wireframe () Mone
|| Output Cantral
B Dizplay Toal Holder
1| Toolpath
Sirmulation Tool Library Preferences
Uzer Interface B 4lways load last lnaded tool library on startup
Fost Processor Default Tool Library
Lizenzing

Clear

Feset to defaults Cancel Apphy Help

CAM Preferences > Cutting Tools
Note: Menu selections on the left may change depending on module and
configuration

4. Checkthe box to Always load last loaded tool library on start up.

5. Fromthe Default Tool Library section of the dialog, pick the ... button to display the Open
dialog.
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L ® N o

Navigate to the folder where you tool library lie is saved. Select the file and pick Open.
The folder path and file name are then listed in the Default Tool Library field.
Pick OK to close the CAM Preferences dialog.

This Tool Library will now load automatically when you create/open a new part file.
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Load the Default Tool Library

RhinoCAMincludes a pre-defined tool library of both Inch and Metric tools that you can use to
start your own tool library.

To load this tool library:

1. 3 To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.

MILLI'E Program Simulate & S & @

T Machine a Stock ~ ‘. WorkZero  @eg4 Axis &
% Post 88 atign - | = 2. ~ \CET R
i:t Setup ~ !E Material AJ 3 Axis Adv T l—li—lHoles *

Machine Setup Stock Machining Operaticns

=~ Machining Job

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

2. Selectthe Tools tab from the Machining Objects Browser.

J'g Tools GRegions %Features %E K-Bases
T aBaear o ey
Itm Tools

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

. @f Select the Load Tool Library icon to display the Open dialog.
From the Open dialog set the file type to Tool Library Text Files (*.csv).
Navigate to C:\ProgramData\MecSoft Corporation\RhinoCAM 2026 for Rhino 7.0 or 8\Data.

o v oA w

There are two tool libraries in this folder:
DefaultEnglishTools.csv
DefaultMetricTools.csv

7. Select the tool library to load and pick Open.

8. You will see a message alerting you that tools are being loaded from a library. Pick OK and
all tools in the library are loaded into the current part file and the tools are listed in the
Tools list of the Tools tab.
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| 15 tool(s) successfully loaded from library.

J'g Tools GRegions %Features He K-Bases

T (Gl & 7 gy

=] Itm Tools
|

£ QX O IO 10X O

¥

MILL Module Shown, Similar for TURN, MILL-TURN and

BallMill - 1/2" 2FL-HSS
FLATMILL-142 INCH
FLATMILL-1/4 INCH
FLATMILL-1/8 INCH
FLATMILL-3/4 INCH
BALLMILL-1/2 INCH
BALLMILL-1/4 INCH
BALLMILL-1/8 INCH
“F*"DEG

=

Profile-NEST Modules

9. If you have tools already created in this part file they are not removed. The toolsin the

library are just added to your Tools list.

© 2026 Mecsoft Corporation



Orient a Part for Machining 105

Orient a Part for Machining

RhinoCAMincludes an Orient Part command to help you quickly change the part orientation for

machining.

1. Open the part file you wish to orient.

2. Select the Program tab.

Program Simulate o -8 @

I Machine aStock A ‘- Work Zero a4 Axis ~ B
%5 Post @Angn - | = 2 s - {’gaﬁ\xis - Bg.

'1:,3::' Setup ~ ;E Material AI‘J, 3 Axis Adv ~ &Holes -
Machine Setup Stock

Machining Operations

=l Machining Job

-
3

-
<
2 B

CQrient

Fart ' Select Orient Part to display the dialog.

© 2026 Mecsoft Corporation

5P "/ From the Program tab, select the Setup menu.




106 RhinoCAM 2026 Q&A Guide

4.

Orient/Locate Part Geometry

SetWwaorld Coordinate System

Set Look Down Direction

Default
4.

5 g
O | @]
1
0

Align to Geomety

Select Surface: Select Planar Curve: | R

Align to Current Yiew Align ta Current C-Plane

Rotate About

Spin Angle: : %] [7] [z
SetWiCS Origin
ko JEvp [EHzp ER

] Cancel

Dialog Box: Orient Geometry

From the Set Look Down Direction section of the dialog, select the direction you want to
machine. While this dialog is displayed, the machining axis will display on the part. The Z

Axis (Blue) should point toward the direction you want to machine.

Set Look Down Direction

Default

A
Ony , e©
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5. Pick OK and the part will be re-oriented with that direction facing the positive Z axis.

6. There are other options on this dialog to help you orient the part. Select the Help button
to learn about them.

1] Related Online Help Topics
User Interface

Orient Part, Setup
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Post G-Code

Once machining operations are created they can be post-processed to a specific machine
controller. To post-process a machining operation, select the operation in the browser, right click
and select Post. The product comes with a set of over 300 post-processors to choose from. The
current post-processor and g-code is also stored with the Part file. The current post-processor and
latest G-Code is stored with the part file for better CAM Life-cycle Management.

[T How your Post-Processor is Stored

When you set the current post-processor for your Machining Job it is saved with your part
file when the file is saved. This keeps the post-processor used to generate your g-code
associated with your part file for better CAM Life-cycle Management.

= Machining Job
Machine - 3 Axis

{; Post - Haas_with cut_comp-MM_REVS é

f:f] Stock - Box Stock
@ Fixtures - None
=[5 Setup1
[ 2142 Axis Facing
Control Geometry
[ FLATMILL- 3/4 INCH
? Feeds/Speeds

“f Clearance
Parameters

Toolpath
" G-Code
l-‘ij In-process Stock
2 1/2 Axis Pocketing
2 1/2 Axis Pocketing
21/2 Axis Profiling

The Current Post-Processor is stored with your Part File

[T] How G-Code is Stored

When you post-process a machining operation from the Machining Job, the G-Code data
is also saved with your part file when the file is saved. This keeps all cam data together
for better CAM Life-cycle Management. If you see that the G-Code icon is flagged, it
means that the latest G-Code has not been captured. Regenerate the operation and the
flag will be removed.
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=-{, - Machining Job
y Machine - 3 Axis
i Post-Haas
@ Stock - Box Stock
@ Fixtures - None
=& Setup 1
=+ 21/2 Axis Facing
Control Geometry
]’ FLATMILL- 3/4 INCH
? Feeds/Speeds
[ Clearance
ét Parameters
Toolpath
B
LTJ In-process Stock
|} 21/2 Axis Pocketing
| 271/2 Axis Pocketing
| ) 21/2 Axis Profiling

The G-Code Item within the MOp Folder

[T] Editing G-Code from the MILL module

You can view or edit your G-Code from an operation that you have generated by simply
clicking on the G-Code icon within the mop folder.

=1, Machining Job
y Machine - 3 Axis
iz Post- Haas
fjﬂ Stock - Box Stock

@ Fixtures - Mone
=& Setup 1
[=-+| 7 Horizontal Roughing
Control Geometry
]’ FLATMILL- 1/2 INCH
: Feeds/5Speeds
€[ Clearance
é( Parameters
Toolpath
Y G-Code
i!r.:l In-process Stock
| | Parallel Finishing
| | Radial Machining

G-Code Browser: Tool Crib menu item

The Machining Browser will be replaced with the Edit tab of the G-Code Editor module.
To return to the MILL module pick the left arrow icon at the top of the G-Code Editor
browser. For documentation on using the G-Code Editor Edit tab click on the "?" help
icon located at the top right side of the G-Code Editor browser.
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Edit
é: Add Line #s __Delline#s & Cut & Find.. ok Print
AV |nsert Spaces | AY Del Spaces = Copy i."'] Replac = Save ~
“y Upper Case ‘451 Lower Case - Paste ) Undo @ Info
1 % ~
2 Q0
3 N1G40G45GSB0
4 {Horizontal Roughing)
5i M2 (Tool Diameter = 0.5 Length = 5.0 )
e HN3G54
7i H4G20T1ME
g2 N5 S8000M3
STEGEONOY TEY S

G-Code Browser: Tool Crib menu item

[ Steps to Manually Post G-Code
1. Create and adjust the toolpath operations that you want to post G-Code for.

2. Make sure the toolpaths have generated cleanly. Each toolpath when generated
is listed under a Setup in the Machining Job. If the operation is flagged it means
thatit needs to be regenerated.

=, Machining Job
y Machine - 3 Axis
i Post- Haas
a Stock - Mone
Fixtures - Mone
o-FR Setup 1
_‘. Work Zero
| | 271/2 Axis Pocketing (Upper)
| | 21/2 Axis Pocketing (Lawer)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

= Post bomthe Program tab, select Post to display the dialog.
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MILL iﬂ Program Simulate & -8 @

-~
o Machine [P Stock = o WorkZero Sl Auis ~ SR~
25 Post %Angn - | = 2 s - {:fSAXis - Bg.
Setup ~ = Material I\J: 3 Axis Adv ~ I—i,—IHoles -

Machine Setup Stock Machining Operations

= Machining Job

Note: MILL Module shown, Similar for MILL-TURN, TURN and

Profile-NEST
Select Post-Processor *
Select Post-Processor
Post-Processzor type
(®) Lse Legacy Post (0 Use Programmable Post

Select Post Processar

Current Post Processor | Haas « || Edit...

Folder where post-processor files are located:
C:\ProgramD atahMecSoft Carporation'

Cancel Help

Dialog Box: Set Post-Processor Options

111

4, SelectaPostfromthe Current Post Processor selection menu. See How to

Define the Post-Processor for more information.

Select Post-Processor *

Select Post-Processor

Post-Processor type

(®) lse Legacy Post (0) Use Programmable Post

Select Post Processar

Current Post Processor: | AbilibyS pstems w || Edit
. G5E218M ~

Folder where post-proce: BF a8

C:\PrqgramData\MecS

Haas_with clag cormp-kd i
Haas_with cut_comp

Handh
Pt s
5. Make sure you have simulated each toolpath and are satisfied with each toolpath
operation. See How to Simulate a Toolpath for more information.
6.

Select the operation that you want to post. You can select multiple operations by

pressing the <Ctrl> key while selecting. You can also select an entire Setup or the

entire Machining Job.
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=1~ Machining Job
M Machine - 3 Axis
i Post-Haas

a Stock - Mone
@ Fixtures - Mone
B E Setup 1
‘.' Work Zero
() 2 1/2 Axis Pocketing (Upper)
l_ 2 1/2 Axis Poclagting (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

7. Right-click on the selected operation(s) and select Post to display the dialog.

=, Machining Job
y Machine - 3 Axis
i Post- Haas
a Stock - Box Stock

@ Fixtures - Mone

=--Fi Setup 1
‘. Work Zero
|__ 2 1/2 Boas Pocketing (Upper)

[J 21/2 pxisPo| @ Regenerate

“:‘; Post

Simulate

Note: MILL Module shown, Similar for MILL-TURN, TURN
and Profile-NEST

8. Your Current Post is listed at the bottom of the dialog. You can change it here if
desired.

L

This PC
l# £ >
Network
File name: ~ | I Past
Save as type: Posted Qutput Files (" nc) ~ Cancel
Current Post: v |

[ Do natshow thiz dislog again

9. Navigate to the folder where you want the posted G-Code file to be saved.
10. Adjust the name of the G-Code file if desired.

11. Make sure the file extension (example: .nc) of the G-Code file is correct and that
your CNC machine controller will read this file extension. Refer to your
controller manual for this information.

12. Select the Post button and the G-Code file is calculated and displayed.
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Mj how-to-2x_2 1_2 Axis Pocketing (Upper).nc - N... - O X
File Edit Format View Help

B A
0e

N1G48G49GE0

(2 1/2 Axis Pocketing (Upper))

N2(Tool Diameter = ©.25 Length = 3.8 )

N3G54

NAG28T2M6

N5 SS5eeaM3

NEG9AGEX1.3987Y1.179

N7G437Z8.15H2

N8 G1Z-8.8542 F28.

NS Z-8.8792 F306.

N1@ X1.3945Y1.178271-90.0799

N11 X1.7%73¥1,17597-0.7813

-

13. G-Code files are ASCII Text Files and by default, are displayed in notepad, a
windows generic text editor.

14. You can review the G-Code and make any manual edits if needed and save the
file from notepad.

15. If you use a different text and G-Code editor program, you can tell RhinoCAM to
display your G-Code files in this program. To do this select Post from the
Program tab to display the dialog.

16. | In the section of the dialog were it says Program to send posted file to select
the ... button to the right to display the File Open dialog.

Program to send posted file ta

| notepad | I%

17. Locate the .exe program that you use to edit your G-Code files with and then
press Open.

18. Then pick OK to close the Set Post-Processor Options dialog.
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Print a Tool List

Follow the steps outlined below to print your Tool List:

1

The Tool List is based on the tools currently listed under the Tools tab of the Machining
Objects Browser. If you want to print your tool library list, first Load your Tool Library so
that all of your are listed in the Tools tab. See Create a Tool Library to learn how to Load

your Tool Library.

From the Tools tab, select the Tool List icon:

Irg Tools GRegions .\i.]
Tidrarar vy

Features E K-Bases
2|

= m Tools

T 375 4FL(2550Lac)
T 375 4FL(1.150Loc)

List Tools i

T 375 4FL (950 Loc)

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

From the Cutting Tools Information dialog, pick the Print button.

Cutting Tocks Information

ooy intarmanon

Marse Teed Tyt Duarste Coted Faths  Tagsr' Futellingh  Ted Langh
ISAFL(25501se) MM 0T Omm Odey  2SEem 43
WEALIMLe) Wtes  Oms Gdy LlEem 12
ITAFLY 380 Lae) w iTtes  Omm Goe Oem 14mn
WMFLIIML) 0iTtes s Gdm Likms 20t
75 I 90 kec ) - 3% G Gdeg Ofmm 2 e
TS ARL {1050 s b - R E T e Gdeg 105mm 154 mm
W2 IR e b - LEEL ] £.8875 o Cdeg QS HE
TS0 4FL{ TSlLec b ™ 0¥ 0125 Bdeg  OTSem 25mm
250 2FL{ TS0Lec b ] 0Xmm D125 Gdeg  OTSem 25mm
250 2FL{ B00Lox b ] Lmm e Gdeg  Obem 25em
2504FL{ B00Lewt - 025 O 0dey  Oem 25mm
BOAFL(LISOLes) M 02 O Odey  Llsem Ak
HOAAL(1TIe 1 LT S Goey  1Tiem EETE
187 2L e b w OUTms  Omm Goe Obem 2Hmn
TR B0 b L 00T - L L] O 2
TR RS e b a O1fT fmm L] O L)
ALEELNE L] - o1t fom Cdeg O H
1BTARL | 850 Lec | - EHTSen  00NTSem  Odm  OESem 2em
187 2L | BS0Le b - OMTSen  00NTSem  Ody  DESes 2mm
125 4FL | 750 Lee | - 0iSme O Gdeg  OTSem 23mm
128 2L T80 Lee ) - 0i%ms  Oms Gdeg  O7Sem 23mm
1284FL{ 520 Loe ) - 0i%ms  Oms Gdey  D%2em 25mm
138 2FL{ 520 Lo ) ™ Siimm  Ome Odey  Ofdem FETON
Y 4L S b - 01 0625 s Goe 052 15
PR S e b - G- £.0825 e Goeg [ 1. G
250 Wood Rosghter | 7. b OXmm e Ghg  OTmm  em

i

ii%ii;

e T T T T

11134313444

FEEREES
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Save a Knowledge Base

RhinoCAM includes powerful Knowledge Base functionality that makes "push button"
programming a reality. You can archive an entire machining strategy specific to a certain class of
parts in a Knowledge Database (also referred to as a K-Base) and then optionally assign Geometry
Selection Rules that are applied automatically when toolpath operations are selected for use from

the Knowledge Base.
1. Create and adjust the toolpath operations that you want to include in your knowledge

base.

2. Make sure the toolpath has generated cleanly. Each toolpath when generated is listed
under a Setup in the Machining Job. If the operation is flagged it means that it needs to be

regenerated.

= Machining Job
y Machine - 3 Axis
iz Post-Haas

e Stock - Mone
Q Fixtures - Mone

=--Fi& Setup 1
i ‘. Work Zero
2 1/2 Axis Pocketing (Upper)
2 1/2 Axis Pocketing (Lower)

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Make sure you have simulated each toolpath and are satisfied with each toolpath

operation.
4. Selectthe operation that you want to save to the Knowledge Base for. You can select
multiple operations by pressing the <Ctrl> key while selecting.

= Machining Job
¥ Machine - 3 Aoz
iz Post-Haas

@ Stock - Mone
_@ Fixtures - Mone

-5 Setup 1

N ‘. Work Zero
21/2 Axis Pocketing (Upper)
2 1/2 Axis Poclagting (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

5. Right-click on the selected operation(s) and select Save to Knowledge Base.
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6.

7.

8.

=-{,- Machining Job

y Machine - 3 Axis

£ Post- Haas

a Stock - Box Stock

@ Fixtures - None

=& Setup1

‘-WorkZero

M8 2 172 fvis pockeiing ooco)

L 21.!’2Axi!ﬁ Regenerate

LR
i Post

@ Simulate

Simulate Until

~
L)
A

Information

# =

Edit
Rename
Suppress
Cut

Copy

Paste

g 8 (X 3¢ s

Save to Knowledge Base %

Note: MILL Module shown, Similar for MILL-TURN, TURN
and Profile-NEST

The Save As dialog is displayed and automatically navigates to the Defaults folder for
RhinoCAM. Enter a name for the Knowledge Base file and pick Save (Example:
My _Knowledge Base.vkb)

Only one Default Knowledge Base can be loaded at a time. However, you may want to use
multiple different Default Knowledge Base files.

& To change the Default Knowledge Base select the CAM Preferences icon from the
Machining Objects Browser to display the dialog.

MILL |3 Program Simulate & - @
- A :
I Machine 6 Stock = w WorkZero Qg4 fuis * SR 7
. [ /
2% Post Align ~ | =7 2 Axis ~ 5 Avis = Bge
: Boar - - 4
-5 Setup * !: Material l\_r, 3 Axis Adv ~ |_£—|HDIE5 *
Machine Setup Stock Machining Operations

=1 Machining Job

Note: MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

Select Machining from the left to display the Machining Preferences.
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Preferences *x

| . .
Geometny Toolpath Generation Settings
|

Features Default Tolearance for MOps 0,007

Stack
Part Sampling Fezolution

Standard bl exdivam Fine

Cutting Tools
Feed: & Speads

| tachining ]
I Dutput Cortral Meshing Parameters

| Toolpath Aspect Ratio: 1.47421
Simulation Mawimurn Edge Length 0,04

Uszer Interface . .
Toolpath Arc Fitting Control [ requested in MOp]
Post Processor
b aimum Arc Radius: 10 =
Licensing E—

B &lways generate toolpaths in multiple threads

Default Machining O peration (MOp] Parameters

| Load from Knowledge Base:  Undefined e
| Source folder for Knowledge Baze:
C:4ProgramD atah M ecSoft CorporationtVisualCak 20245De

| Supprezsed MOps Behavior
| B Do not Simulate

B Do not Post

B Lo not Regenerate

B Lo not allow Edits

B Dot Delete

Rezet to defaults Cancel Spply Help

CAM Preferences: Machining

9. From the Default Parameters section select the Default Knowledge Base to use from the
menu. If you have saved different Default Knowledge Base into the Defaults folder, they
will be listed here.

Default Farameters

Default Krowledae Baze : | Undefined w

Undefined
Source folder for Knowledge fvailableH oleM O psit

C:%ProgramD atathecSoft [ 4vailableH olebd O pshd i
by _Default_Parameters

10. If you set this to Undefined, the factory defaults are used when creating an operation.

Default Parameters

Cefault Knowledge Baze : | My _Defaul_Parameters

Source folder for Knowledg fvailableHoleMDpsIM

C:\PrograrmD atatMecSoft [ AvailableHolebd Opsbd b
by Defaull Parameters

© 2026 Mecsoft Corporation



118 RhinoCAM 2026 Q&A Guide

Save a Tool Library

Creating a tool only assigns that tool to the part file you are editing at the time. To use your tools
repeatedly for other part files you need to create a tool library.

1. Open the part file that contains tools that you want to save to a library.

2. 3 To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.

MILL iﬂ Program Simulate & S & @

‘y Machine a Stock ~ ‘. Work Zero g—'.ti,ﬂ\xis - HE-
% Post 88 atign - | = 2. ~ \CET R
= Setup ~ 3= Material AJ 3 Axis Adv ~ ri'—lHDIES -

Machine Setup Stock Machining Operaticns

=] Machining Job

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3. Selectthe Tools tab from the Machining Objects Browser to see your list of tools.

J'g Tools C}Regions %Features Ho K-Bases
T aBaear o ey
I'_m Tools

[ o

hgf From the toolbar below the Tools tab select the Save Tool Library icon.
From the Save As dialog that displays, enter a File Name for the tool library.
Select a folder where you want the tool library file saved.

By default tool library files are extended with a *vkb file extension.

©® N o s

Pick Save to save the file.
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Save Defaults

RhinoCAM can save all of your machining parameters as default settings so that they are loaded
automatically each time you create the same toolpath operation. This is your first step toward

toolpath automation.
1. Create and adjust the toolpath operations that you want to save defaults for.

Make sure the toolpath has generated cleanly. Each toolpath when generated is listed

2.
under a Setup in the Machining Job. If the operation is flagged it means that it needs to be

regenerated.

= Machining Job
y Machine - 3 Axis
i Post- Haas

e Stock - Mone
Q Fixtures - Mone

- FE Setup 1
- ‘. Work Zero
21/2 Axis Pocketing (Upper)
2 1/2 Pxis Pocketing (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

Make sure you have simulated each toolpath and are satisfied with each toolpath

operation.
Select the operation that you want to save defaults for. You can select multiple
operations by pressing the <Ctrl> key while selecting.

= Machining Job
y Machine - 3 fxis
s Post-Haas

@ Stock - Mone
@ Fixtures - Mone
=--Fid Setup 1
N ‘. Work Zero
21/2 Axis Pocketing (Upper)|
2 1/2 Axis Poclssting (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

5. Right-click on the selected operation(s) and select Save as Defaults.
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=-{,- Machining Job
y Machine - 3 Axis
s Post-Haas
a Stock - Box Stock
@ Fixtures - None
=& Setup1

‘. Waork Zero

2 1/2 Axis Pocketing (Upper)
[ 212, @ Regenerate

:J';. Post

@ Simulate

Simulate Until

e

k{!p’ Information

E Edit

Rename

Suppress

-

o} Cut

2 oo

Ej Paste

lL_.k‘ Save to Knowledge Base
Save As Defaults I,\\}

IjJ Properties

Note: MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST

The Save As dialog is displayed and automatically navigates to the Defaults folder for
RhinoCAM. Enter a name for the defaults file (for example: My_Default_Parameters.vkb)
and pick Save.

The defaults are saved as the Default Knowledge Base file with a .vkb file extension and
the CAM Machining Preferences are set automatically to use this Default Knowledge Base
file.

Only one Default Knowledge Base can be loaded at a time. However, you may want to use
multiple different Default Knowledge Base files.

& To change the Default Knowledge Base select the CAM Preferences icon from the
Machining Objects Browser to display the dialog.

Select Machining from the left to display the Machining Preferences.
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Preferences *x

| . .
Geometny Toolpath Generation Settings
|

Features Default Tolearance for MOps 0,007
Stack
Part Sampling Fezolution

Standard bl exdivam Fine
Feed: & Speads -

Cutting Tools

[ [ tachining ]
I Dutput Cortral Meshing Parameters

| Toolpath Aspect Ratio: 1.47421
Simulation Mawimurn Edge Length 0,04

Uszer Interface . .
Toolpath Arc Fitting Control [ requested in MOp]

Post Processor
b aimum Arc Radius: 10 =

Licensing

B &lways generate toolpaths in multiple threads

Default Machining O peration (MOp] Parameters

| Load from Knowledge Base:  Undefined e
| Source folder for Knowledge Baze:
C:4ProgramD atah M ecSoft CorporationtVisualCak 20245De

| Supprezsed MOps Behavior
| B Do not Simulate

B Do not Post

B Lo not Regenerate

B Lo not allow Edits

B Dot Delete

Rezet to defaults Cancel Spply Help

CAM Preferences: Machining

10. From the Default Parameters section select the Default Knowledge Base to use from the
menu. If you have saved different Default Knowledge Base into the Defaults folder, they
will be listed here.

Default Farameters

Default Knowledae Baze : | My_Defaul_Parameters

Source folder for Knowledge Base:

| C:%ProgramD ataskecSoft Corporation’, |

11. If you set this to Undefined, the factory defaults are used when creating an operation.

Default Parameters

Cefault Knowledge Baze : | My _Defaul_Parameters

Source folder for Knowledg AvvalableHoleMOpsiN

C:\ProgramD atashecSoft [ AvailableH olebd O psbd b
My Default Parameters
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Set Preferences at Start Up

The steps below will assist you in making sure the correct preferences are loaded at start up.

Important: When you install the plug-in (near the end if the installation) the program will ask you
if you want to use your existing settings. Make sure you say YES. If you said NO, or if your
preferences have changed without your knowledge, then follow the steps below to recapture
your preferred settings manually.

To open new files using a default template file:

1.

2.

Open an existing file that has your settings defined (i.e., post, tool library, etc.).
Save the file and the settings will update in the Windows registry.

As a check, open a new file and go to the Program tab > Post and look at the Select Post-
Processor dialog.

Make sure your correct post is selected. If not, use the ... button to browse and select the
folder where you post is and pick OK and then OK again.

For new files you can open the Template file. If not, that's OK, RhinoCAM/Visual CAM will
load with your settings.

To load a default Tool Library at start up:

1.

Check the Tools tab. If yourtools are not loaded by default, go to the CAM Preferences
dialog (Machining Browser > CAM Preferences (the gear icon at the right side of the
browser)) and go to the Cutting Tools tab.

Use the Tool Library Preferences section, make sure your tool library is listed in the
Default Tool Library field. If not, use the ... button to locate your tool library and pick OK
and then OK again.

To load a default Knowledge Base:

1.

If you have a default knowledge base, go to CAM Preferences and from the Machining tab
make sure your knowledge base is selected from the Load from Knowledge Base drop-
down menu. If not, highlight and copy the source folder for knowledge bases. Then open
the windows file browser and navigate to that folder and copy your knowledge base file to
that folder.

Now close and reopen the CAM Preferences tab and make sure your default KB is selected
and pick OK.
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General options for handling your CAM Preferences:

1. Openorstartanew file and make sure your preferences are correct.

2. Go to the CAM Preferences dialog by selecting the gear icon from the Machining Browser
(top-right and to the left of the help ? icon).

3. Select the User Interface tab.
4. There 4 options under the Save Preferences section.

5. Un check the third check box and the large button that says "Always save current
preferences to registry on exit" will be activated.

6. Select this button and all of your current preferences will be saved to your Windows
registry.

7. Test this by closing and reopening RhinoCAM/VisualCAM and your default preferences
should load by default.

8. The three check boxes are self-explanatory. Use them to set how preferences are
loaded/saved.
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Setup a Part

To setup a part for machining perform the following basic steps. These are similar for all types of
parts.

1. Check and know the part units (Inches/Millimeters). Only these two units are supported
in CAM.

2. Check the orientation of the part to make sure it can be machined. By default the Z axis is
the machining direction. Typically the X axis points toward the right or along the bed of
the CNC machine. The Y axis typically points to the back of the CNC machine.

3. See How to Orient a Part for Machining for a quick way to orient the part.

4. Selectthe Program tab.
MILLle Program Simulate o g -8 @

B Al .
y Machine e Stock T ‘- Work Zero  ©<a4 fois = J&
25 Post @Angn - | = 2 s - @mm - Bg.
- . \ i . :
-03 Setup T !: Material = M 3 Awis Adv ™ I—£—|H0|ES hd
Machine Setup Stock Machining Operations

= Machining Job

5. |3 Machine| 5ot the Machine definition to either 3, 4 or 5 axis depending on your machine
tool and part requirements.

6. @ Pt Setthe Post-Processor definition.
7. (@ seek"| pefine your stock size and material.
g. |68 an | Align the Stock with the Part if needed.

9. WM WekZero| gy qefaylt the program zero will be measured from the WCS (World
Coordinate System). You can create an alternate Work Zero location if needed.

=4~ Machining Job
y Machine - 3 Axis
£ Post- Haas
a Stock - Box Stock
@ Fixtures - Mone
=& Setup1

‘- Work Zero
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Simulate a Toolpath

RhinoCAM allows you to simulate your toolpath to see the cut material removal and in-process

stock.

Here are the basic steps to simulate a toolpath:
First create a toolpath to simulate and make sure the toolpath has generated cleanly. Each

1.
toolpath when generated is listed under a Setup in the Machining Job. If the operation is
flagged it means that it needs to be regenerated and cannot be simulated yet.

= Machining Job
y Machine - 3 Axis
iz Post-Haas

e Stock - Mone
Q Fixtures - Mone

= E Setup 1
‘. Work Zero
2 1/2 Axis Pocketing (Upper)
2 1/2 Axis Pocketing (Lower)
Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

2. From the Machining Job, select the operation that you want to simulate.
= Machining Job

y Machine - 3 Axis

s Post-Haas

@ Stock - Mone

@ Fixtures - None

= E Setup 1

‘. Work Zero

21/2 Axis Pocketing (Upper)|

2 1/2 Axis Poclssting (Lower)

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Select the Simulate tab. Its located to the right of the Program tab.
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W Program Simulate [E

> &0

oy
Preferences

¥ Drey  [Toknd
[¥] simulate by Moves @Step Pause

Options Simulate

e Stock ~ Step Levels D Stop

@ompare

=l Machining Job
9@ Machine - 3 Axis
r% Post - Haas
; a Stock - None
I@ Fixtures - None
E| ----- @ Setup 1

‘. Work Zero

----- E__) 2 1/2 Axis Pocketing (Upper)

----- [ 2172 Ais Pocketing (Lower)

Note: MILL Module shown, Similar for MILL-TURN, TURN and

Profile-NEST

4. 3P| pick the Play button to run the simulation.

ij You can toggle off the toolpath to see the resulting in-process stock model by

selecting the Toggle Toolpath Visibility icon from the base of the Machining Browser.

You can slow down the simulation by adjusting the slider located on the Simulate tab

menu. You can further slow down the simulation by un-checking Simulate by Moves from

the Simulate tab menu.
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Imiﬂ Program Simulate & F -8 @
Preferences e Stock ~ Step Levels Stop
" Pla)r TD End @:Dmpare
[C] simulate by Moves Step Pause
Options Simulate
Note: MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

7. Pause| Lo TeEnd| yoy can fast-forward to the end of the simulation by selecting Pause and
then To End.

8. *'¥P| To see each cut motion one at a time, you can select the Step button.

9. Pre“E’e”ces You can set simulation preferences by selecting Preferences from the
Simulate tab menu.

10. 55: You can apply a Stock Material texture to the simulation by selecting the Toggle
Material Texture Visibility icon from the base of the Machining Browser.

11. If the in-process Stock does not display on the screen during the simulation, make sure
you have simulated all previous operations that appear in the Machining Job.
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Suppress a Toolpath

You can Suppress a machining operation or a Setup in the Machining Browser by selecting it, right
click and select Suppress from the context menu. Suppressed operations will not be displayed,
posted or simulated. You can also right-click and Unsuppress an operation. Note: You can
customize how suppressed operations are managed using the Machining Preferences dialog.

[T] To Suppress an Operation

= Machining Job
y Machine - 3 Axis
s Post-Haas
@ Stock - Box Stock

@ Fixtures - None

B E Setup 1
‘. Wark Zero

2 1720
ﬁ Regenerate

‘.:_;. Past

Simulate

Simulate Until
P )
l.\!,.’ Information
W) et

Rename

& Suppress I:E

b Cut

I?‘ﬂ Copy

To Suppress an Operation

MILL Module shown, Similar for MILL-TURN, TURN and

Profile-NEST

[T] The Suppressed Operation Icon

A Suppress operation will display in the Machining Job with the following icon:
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=-{, - Machining Job
y Machine - 3 Axis
iz Post- Haas
a Stock - Box Stock

@ Fixtures - Mone

= g Setup 1

‘- Work Zero

=] f; Horizontal Roughing
Control Geometry
i Fatmin-o2s
E Feeds/Speeds
Clearance
S Parameters
Toolpath
@ In-process Stock
| | Parallel Finishing
| 271/2 Axis Profiling
Suppressed Operation Icon
MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

[T] To Unsuppress an Operation

To Unsuppress an operation, right-click on it and select Unsuppress.

=~ Machining Job
3 Machine - 3 Axis
5;? Post - Haas
a Stock - Box Stock

@ Fixtures - None
=& Setup 1
‘- Work Zero
=] g Hrizantal Rough/ifu_l\
Control Geg k!/ Information
5 .
[ Flathinl-0.2s
Feeds/Speed

Clearance Il’i:ﬂ Unsuppress
Parameters | m

Toolpath | &% Cut
@ In-process § Properties
| | Parallel Finishing
| ] 21/2 Axis Profiling
To Unsuppress an Operation
MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

Rename
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Use these help topics

These How To ... help topics are quick answers to some of the many questions you will have as a
new user starting out. They are arranged in the order that is typically used to create and work
with toolpaths in RhinoCAM. Here are some suggestions on how to use these topics:

1. If you are new to RhinoCAM, we suggest that you first take some time to complete the
Quick Start Guide. It walks you through the basic procedure to create a toolpath. See the
Videos & Guides topic for more information.

2. Next, take some time to read through all of these How To topics. The topics are short,
providing quick information.

3. Thenrefer back to a specific topics later as you need to refresh your skills.

4. Remember that each dialog in RhinoCAM has a Help button that you can select to display
the online help for that dialog.
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Why are my Feed Rate values too High/Low?

If your Feed Rate values in your posted g-code are too High ortoo Low, you can adjust the
High/Low parameters in the Post Processor following the steps outlined below:

1. Click on Post (Set Post-Processor Options), then click Edit.

M|LL|.’$ Program

¥ Machine f_:ﬂ Stock ™

i Post % Align =
e SetuFNE Material

Stock

Machine Setup

Simulate

<
=

g

Select Post-Processor

Select Post-Processor

Fost-Processor Type
(® Use Legacy Post

=}~ Machining Job

i Post- Haas

-5 Setup 1

B3

EH-E--E-3

y Machine - 3 Axis

@ Stock - Box Stock

@ Fixtures - Mone
[ 2 1/2 Axis Facing

| 271/2 Axis Pocketin
| ] 21/2 Axis Pocketin
|} 21/2 Axis Profiling

/Select Paost Processar

Current Post Processor:
Haaz ~

lder ta load post-pracessor files from:

() Use Programmable Post

Edit ...

s

C:4ProgramD atasMecSoft Corporation R hinoCakd 2027 for
Rihita B.0%Pastz Millh 5Pk

Cancel

Help

Note: MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

2. Fromthe Post Processor Generator dialog, select the Feed Rate tab from the left.

3. Then make the necessary changes under the Feed Rate Value section for either the High
Value or Low Value.

Post-Processer Generator

General

[ Dustpust i e tiwes Feediate for 4 & 5 Aoz motions

O Code:

Dedauk

2 Feed Riste Scale Factor |

Stat/Erd Block Format =
Toal Change Feed Rale Code ] iudd it Mest Mistion Ciode Irresze Time Feed Rate
Setup |
Spinde Feed Rate Modes
|Feed Ratel [
Mation Urats/Min Code: Unite/Flev Code: On Code
Cicle
Hebcal’Speal
M Axiz Motion Block Foomat
Cuter Clmmmm FIFEEDRATE]
Cust Motion Start/End
- Cycles
Misz Sample Dutput
Wanables
Fi
Feed Rate Value
High'Vahue 10001 Seale Factor 15
LowVae [ 1 HolDecimal Places | 0/
Angular Feedate Vakue
ScaleFactos | 105 Hol Decinal Flaces [ 115

4. Then pick Save.

Show TislirgZero: [

Save Az Help
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